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License Agreement

The use of Adagio MultiCurrency from Softrak is governed by the following agreement. You
demonstrate your acceptance of the terms of this agreement by using Adagio MultiCurrency
and its associated materials. You may terminate this agreement at any time by sending a
letter to Softrak Systems Inc. stating that all copies of the software have been destroyed. The
letter must be signed by an officer of the company.

Usage Rights

For the fee you have paid, Softrak Systems Inc. hereby grants to you and you accept a license
to use Adagio MultiCurrency and its related materials on a single computer system only. To
use any Adagio applications on more than one computer system, you must either purchase a
license for another copy of that Adagio product or arrange for a multi-user license from
Softrak Systems Inc. You may not copy any of the materials received with Adagio products,
in whole or in part, except for archival and backup purposes.

The license is not transferable.

Registration and Support

To receive technical support and notices of upgrades and announcements, your copies of
Adagio MultiCurrency must be registered.

To register, install Adagio MultiCurrency as you would any other Windows application.
When you start up any Adagio application for the first time, you will be presented with a
screen that gives you the option to register. Enter your company information and print the
registration form to be mailed or faxed to Softrak Systems Inc.

Adagio MultiCurrency requires registration within 60 days of first use. It will cease to
operate after 60 days have elapsed without a registration code.

Liability

You agree that regardless of the form of any claim, the liability of Softrak Systems Inc. for any
damages to you or to any other party shall not exceed the license fee paid for the materials
included in Adagio MultiCurrency. Nothing in this agreement shall be construed as a
product warranty and all such warranties are explicitly and expressly denied.
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Chapter 1
Multicurrency

Overview

Adagio MultiCurrency allows you to set up currency information so that you can use
multiple currencies when entering transactions in Adagio modules, such as Adagio
Ledger.

Its primary functions are:

• To create and manage codes for the various currencies you will be using.
(Chapter 3)

• To specify rate types for various types of exchange rates you wish to use, such
as spot daily rates vs. monthly average rates. (Chapter 4)

• To create and manage currency tables that dictate the method used to convert
a foreign currency into home equivalent values. (Chapter 5)

• To create and manage exchange rates so that Adagio knows where to get
exchange rates from, in order to convert foreign currencies to home equivalent
values. (Chapter 6)

These functions are discussed in detail in the following chapters. Chapter 2 will help
you get started by showing you how to define your DataSet Profile and set program
options.

Adagio MultiCurrency also includes several functions and conventions that are
common to all Adagio applications. Please consult the online Help documentation or
your Adagio Fundamentals manual for these common elements, such as:

• Defining user groups and users
• Backing up data
• Running data integrity checks
• Setting report options
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Once you have set up your database to work with multiple currencies, the modules
in the Adagio suite will:

• give you options to select the currency codes and rate types you’ve set up
here, for transactions processed in those modules;

• and then those modules will use the currency tables and exchange rates
you’ve set up to properly convert foreign currency values in your transaction
processing, posting, budgeting, and reporting throughout the Adagio suite.

Multicurrency Overview
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Security Settings
Adagio MultiCurrency includes a User Setup function that allows the system to
prevent unauthorized users from entering the system and restricts users from
accessing certain areas of the system.

To do all this, you must first set up user groups, which define what parts of the
program the users within the group are allowed to access. For example, you can
allow only senior staff members to access all functions. Then you can set up the
individual users and assign them to the appropriate group level, depending on the
access privileges you want to grant them.

See the online Help documentation or your Adagio Fundamentals manual for complete
information on setting up user groups and users. Entry templates may also be set up
in Receivables user groups which will override template settings created using the
Edit | Entry Templates function.

Adagio Fundamentals
Other important information about Adagio MultiCurrency is included in your Adagio
Fundamentals manual. Adagio Fundamentals covers information and functions that are
similar across all Adagio applications, such as data backup, security settings, and
keyboard shortcuts for data entry. Be sure to read Adagio Fundamentals for valuable
information about working with Adagio MultiCurrency.

About Adagio
Adagio Accounting is designed for organizations that manage over $1 million in
sales/revenue, with significant transaction volume and at least one person
responsible for managing those transactions. This modular accounting system
combines a batch interface that is easy to understand and control with online
processing in order entry and inventory control. Additionally, Adagio provides
dynamite-looking invoices, checks and statements on blank paper. All of this without
being forced to use a mouse during data entry or any of the other accounting
procedures. Simple procedures and built-in software make it a snap to email or fax
letters and customer statements.

Security Settings
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About Softrak
For over 25 years, Softrak has created accounting and reporting software to make the
tasks required in the accounting department simple and straightforward, even in
high volume businesses. If you have any suggestions about how we can improve this
module, please visit our web site at www.softrak.com.

About Softrak
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Chapter 2
Getting Started

In this chapter, we will explain the following procedures:

• Installing Adagio MultiCurrency
• Creating a database
• Opening your database
• Editing the dataset profile
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Installing Adagio MultiCurrency
To install Adagio MultiCurrency:

1) Insert the CD into your CD-ROM drive.

2) If you have Auto-Run set for your CD drive, the install will begin right away.
Otherwise, open the Control Panel and select the Add/Remove Program
function.

See your Adagio Fundamentals manual for a much more detailed guide to
installation.

Installing Adagio MultiCurrency
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Creating a Database
If you do not already have an Adagio database for your company, you will need to
create it now.

If you do have a database that is set up only to work with single currencies, you can
open it and enter your multicurrency settings to begin working with multiple
currencies in that data set in the future. And if you already have a multicurrency
database, you can also skip this section and go right to Opening Your Database to open
your database and begin working with your multicurrency options.

Adagio MultiCurrency comes preloaded with the user ID of SYS and a password
that is also SYS. You must log in with this user ID and password the first time you
use Adagio MultiCurrency. This is the default Adagio system administrator user ID.
It cannot be deleted but it can be changed. Since it provides access to all Adagio
MultiCurrency screens and functions, you may want to change the password for
security purposes. Refer to the online Help documentation or your Adagio
Fundamentals manual for instructions on changing the password.

To create a database:

1) Open Adagio MultiCurrency by calling up your Windows Start menu and
selecting Adagio MultiCurrency from the Adagio menu. The program starts and
the following window appears:

This is the dialog that appears each time you start Adagio MultiCurrency.

Creating a Database

Getting Started Page 2-7



2) Before you can create the database, you must first enter the User ID, Password,
and Date.

Field Description

User ID /
Password

Once your database is created, each Adagio user
will be assigned a user ID and password in File |
User Setup if you want the system to be able to
differentiate between users for security and access
privileges. (Information on security and user setup
can be found in the online Help documentation or
your Adagio Fundamentals manual.) However,
because this is a new database, you must enter the
default information in these fields.

The default User ID is SYS and the default
Password is also SYS.

NOTE: We recommend that you change the Adagio
System Administrator’s password once you have set up
your users.

Date This is the session date. It defaults to the current
system date. If you need to change the date, use the
calendar button to the right, or type in the desired
date.

NOTE: If you want to log in to MultiCurrency using a
session date within the month and year that initially
display in the Date field, all you need do is type one or
two numbers representing the date you want to use. (Eg.
If the date displayed initially is 12/12/2010 and you now
want to log in using a session date for 12/15/2010, all
you need do is type 15 in the date field. The month and
year will populate automatically.)

You are able to use the one or two-character date
entry method in any ‘date’ field within Adagio
MultiCurrency.

Creating a Database
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3) Once you’ve entered the necessary information, click Create to create the
database. The following screen will appear:

Select the drive, path, and extension for your new currency data. This is the
location for the currency files that all of your Adagio modules will use, so
please take the following into consideration:

• If you are only going to be using Adagio for one company’s data, you may
place the currency data in your company’s data directory. For example, if
you are placing your company data in a drive/directory such as
C:\XYZCOMPANY\DATA, use that drive and directory.

• If you intend to use these currency files for more than one company, you
may want to place the data in a more central location, such as
C:\SOFTRAK\SYSTEM.

If an appropriate folder does not exist for your data, you can also
create a new data directory.

There is no need to change the List files of type field. It allows you to select
other file types; but Adagio MultiCurrency is only interested in global files, if
any exist in the selected location.

Click OK to proceed. You will see a prompt asking if you’re sure you wish to
create data at that location. Click Yes.

Creating a Database
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4) Next, you will be asked to indicate the location of some required program files.

This dialog box requires you to complete two fields. Because this is a new
database and you are not opening an existing Adagio database, the program will
default to place these files in the Softrak\System folder.

When working with a company’s database, all Adagio modules must use the
same Currency and EZTasks path. If this is not correct in a multi-user
environment, data corruption may result.

5) Click OK. Your data will be set up according to your specifications.

If the wrong paths are chosen, delete the file ADSPROF.xxx (where
.xxx is your company’s database extension) from your data
directory. Start Adagio MultiCurrency again and open the
database. The EZFile Directories dialog will be displayed. Enter the
correct path information.

6) Once you have created the data, Adagio MultiCurrency will automatically bring
up the DataSet Profile for editing. Please see the section on Editing the DataSet
Profile later in this chapter for more information.

Using Currency Data in Adagio Modules
Once you have created your currency data by following the above process, you will
need to refer to the location of that data whenever you first open a specific
company’s data set in an Adagio module. That will allow the Adagio module to find
and use the currency codes, exchange rates, and other information you set up in this
Adagio MultiCurrency data set.

Creating a Database
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Opening Your Database
To get started with Adagio MultiCurrency on an existing Adagio database, follow
these steps:

1) Open Adagio MultiCurrency by calling up your Windows Start menu and
selecting Adagio MultiCurrency from the Adagio menu. The program starts and
the following window appears:

Opening Your Database
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This dialog box appears each time you start Adagio MultiCurrency. You must
enter a user name and password here, and verify the date, data path, and
extension before clicking OK.

Field Description

User ID /
Password

Each Adagio user will be assigned a user ID and
password in File | User Setup if you want the
system to be able to differentiate between users for
security and access privileges. (Information on
security and user setup can be found in the online
Help documentation or your Adagio Fundamentals
manual.) If you haven’t previously set up users for
this database, you must use the default user ID and
password.

The default User ID is SYS and the default
Password is also SYS.

NOTE: We recommend that you change the Adagio
System Administrator’s password once you have set up
your users.

Date This is the session date. It defaults to the current
system date. If you need to change the date, use the
calendar button to the right, or type in the desired
date.

NOTE: If you want to log in to MultiCurrency using a
session date within the month and year that initially
display in the Date field, all you need do is type one or
two numbers representing the date you want to use. (Eg.
If the date displayed initially is 12/12/2010 and you now
want to log in using a session date for 12/15/2010, all
you need do is type 15 in the date field. The month and
year will populate automatically.)

You are able to use the one or two-character date
entry method in any ‘date’ field within Adagio
MultiCurrency.

Opening Your Database

Page 2-12 Adagio MultiCurrency



Field Description

Remember user name
/ user password

Turn this option(s) on to have the Adagio user
name and/or oasswird renenbered and
authenticated by the Windows user. This allows
you to default your Adagio password by loging
into Windows (on the same station).

Data path Enter the drive and data path for your company's
data by clicking once in this field and typing the
information in, or by clicking the Browse button
and selecting the correct drive and data path from
the Data Selection dialog box that appears.

There is another button to the far right of this field.
Click this 'multiple folder' button to view a list of
Previously Opened data sets. This feature is
especially helpful if you are maintaining multiple
data sets (e.g. Adagio MultiCurrency data for
multiple companies). If you wish to use one of
these previously-opened data sets, simply click the
desired Company Name to select it, then click
Open.

NOTE: Adagio MultiCurrency can remember what
datasets have been accessed by each Adagio user.
The first time each user logs in to MultiCurrency,
they will be prompted to respond whether or not
they want Adagio MultiCurrency to do also load a
default list of companies. (Please refer to page 2-14
for more detailed information on responding to the
historical Company Access List prompt.)

Extension Enter the extension used by your company’s data
here. For example, to access the sample data you
would enter .SAM here.

If you do not have any existing Adagio data, click Create and
consult the Creating a Database section earlier in this chapter for
details.

2) When you have entered or verified the information in these fields, click Open to
open the database and begin using Adagio MultiCurrency. Or, click Cancel to
exit Adagio MultiCurrency at this time. If you need more information on this
screen, click Help.

Opening Your Database
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Historical Access List
MultiCurrency has the ability to maintain separate Previously Opened dataset lists
by user. As such, when users log in to MultiCurrency, their Previously Opened
window will display only those companies/datasets they have accessed which
should speed their search for a particular dataset. when you log into MultiCurrency
for the first time after the data is converted, you will be prompted for whether you
want your Historical Access List set up or not.

Select Yes to have MultiCurrency retain the original list of companies all users have
accessed and then remember which subsequent companies/datasets have been
accessed by each user separately.

Select No to begin with a blank Previously Opened window and have only the list of
datasets accessed by each user since the installation of MultiCurrency 8.1B or higher
display each time the Previously Opened window is opened by that user.

The first time each user accesses MultiCurrency data, they will
receive the same prompt asking if they would like their historical
company access list set up.

Opening Your Database
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Editing the DataSet Profile
The DataSet Profile in Adagio MultiCurrency is very straightforward. It does not
contain any specific company information, as this multicurrency data can be used for
more than one company.

To modify the DataSet profile, select DataSet Profile from the Edit menu, or click the
Profile button on the toolbar. The following window appears:

This window contains only three fields, as described on this table:

Field Description

DataSet Name Enter a name for this currency data set. If you are
using it for a single company, you can enter your
company name here. If you are using it for multiple
companies and/or subsidiaries, you may want to
enter something descriptive to set it apart from any
other multicurrency data sets you may create.

Editing the DataSet Profile
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Field Description

Default Rate URL When Adagio MultiCurrency is installed, Adagio
enters a web site URL that is used as a default
location for obtaining up-to-date currency exchange
rates. The Adagio default URL points to the Federal
Reserve Bank of New York.

There are many other places to obtain exchange rate
information on a daily basis, including your own
bank’s web site in all likelihood. If you wish to
enter a different rate URL, please do so here.

The URL you enter here will be used as the default
when you are setting up your Exchange Rates, as
discussed in Chapter 6.

Auto-backup after
DIC?

Turn this option on to ensure Adagio
MultiCurrency automatically performs a backup of
MultiCurrency data immediately after Data
Integrity Check completes.

If integrity is clean, it appends _Clean to the end of
the backup file name.

In the event Data Integrity Check finds errors and
presents the Rebuild button, a backup is performed
prior to rebuilding errors in DIC. The backup will
have _Prebuild appended to the zip file name.

Please refer to the online Help documentation or
your Adagio Fundamentals manual for more
information on Data Integrity Check and Backup.

This window also indicates the DataSet’s location, which is the location you specified
either when you created this database or when you first opened it in an Adagio
module. This is provided for your information only and cannot be edited.

Click OK to save the Profile and exit out of this function. You are now ready to begin
entering or editing your multicurrency data.

Editing the DataSet Profile
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Chapter 3
Working with

Currency Codes

The Currency Codes function allows you to create and manage codes for the various
currencies you will be using. This function is used to set your default, or home,
currency and to create foreign currency codes.

The codes you create here will then be used to set up your Currency Tables (Chapter
5) and your Exchange Rates (Chapter 6). In addition, these codes are used in other
Adagio modules, when you are entering transactions, to specify the currency in
which the transaction occurred.
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Currency File Locations
As described in chapter 2, when you create a new data set or open an existing
ACCPAC Plus data set for the first time, you will be asked to provide a currency
path.

The drive and path you enter in the Currency path field is where your currency
codes will be located. It is important to note this location, because you will need to
refer to it whenever you first open a specific company’s data set in any of the other
Adagio modules that will use the currency codes and exchange rate information you
set up in Adagio MultiCurrency.

Currency File Locations
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Creating Currency Codes
New currency codes can be created for any currency you deal with. To create a new
code:

1) Select Currency Codes from the Edit menu. The Edit Currency Codes window
appears, displaying your default currency and any existing currency codes you
have on file.

If you created a new data set from scratch, there will be one
currency code already on file, and it will be set as the default. You
can create others and change the default currency and then delete
the original code if you wish.

If you have access to the Column Editor, you may change the fields (columns)
that display on this grid. Please refer to the online Help documentation or your
Adagio Fundamentals manual for more information on working with the Column
Editor.

Use the Excel Direct button to quickly export the contents of this grid to an Excel
spreadsheet, assuming Microsoft Excel is installed.

Creating Currency Codes
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2) Click the New button to call up a blank Edit Currency Code window:

The fields on this window are explained in the following table:

Field Description

Currency code Enter a three-character code for the new currency.
This code will often contain a country abbreviation,
such as CAD for Canada or USD for the United
States.

Description Enter a longer description of the code. You might
use “Canadian dollars” for the code CAD, for
example.

Symbol Enter the symbol used for this currency, such as $
for dollars, or £ for pounds.

Position of symbol Indicate where the symbol should appear. Your
options are to have it appear:

� directly before or after the amount, or
� before or after the amount but separated from

the amount by a space.

Creating Currency Codes
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Field Description

Negative number
format

Indicate your preference for the notation of
negative values. You can place a negative sign
before or after the amount, or you can place all
negative amounts in parentheses.

Thousands symbol Choose your preferred symbol for separating
thousands in amounts. For example, most North
American currencies use a comma, such as
$1,249.63, while most European countries use a
space, such as $1 249.63.

Decimal symbol Indicate whether a period or a comma should be
used as the decimal. For example, $967.75 or
$967,75.

Decimal places Indicate the number of decimal places typically
used by the currency. Enter 0 for zero decimal
currencies like the Japanese yen.

Display format This field simply displays the result of your
selection in the preceding fields, showing your
choice of currency symbol, decimal symbol, and so
forth.

3) When you are finished editing these fields, click OK to save the new code.

Creating Currency Codes
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Setting the Default Currency
Once you have created the currency codes you want to use for this data set, you can
set the default, or home, currency.

To set the default currency:

1) Select Currency Codes from the Edit menu. The Edit Currency Codes window
appears, displaying your default currency and any existing currency codes you
have on file.

2) In the Default currency field at the top of the window, click the Finder button
and choose your default currency from the list of codes that appears. When you
select it, the code will be added to the Default currency field and its description
will appear to the right.

This code will now be used as your default currency for all Adagio modules that
reference this currency data set.

Setting the Default Currency
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Working with Existing Codes
Currency codes on file can be modified, viewed, copied, or deleted as needed. To
work with codes, select Currency Codes from the Edit menu and then use the
buttons on the right side of the window to carry out these functions.

Editing Codes
Existing currency codes can be modified by selecting the code from the list window
and clicking the Edit button; or by double-clicking on the code in the list. All fields
described earlier can be edited except for the code itself.

Viewing Currency Codes
The currency codes on file can be viewed in a non-editable window by selecting the
code from the list and clicking View.

Copying Currency Codes
If you require two fairly similar currency codes, you can create one (or select one on
file), copy it to another code name, and then simply make any minor modifications
required to the newly copied code. To do so, select the code you wish to copy from
the list, then click Copy and enter the new code.

Deleting Currency Codes
If for any reason you find that you do not require a currency code that’s on file, you
can delete it. Just click it once in the list to select it, and then click Delete.

Deleting currency codes will also delete all currency tables and currency rates that
use that currency code.

Currency codes that are still in use in your Adagio data must not be
deleted, or data corruption will result. Adagio does not check your
data files to see if any transactions are using the currency code; you
must check that prior to deletion yourself.

Working with Existing Codes
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Chapter 4
Working with Rate

Types

The Rate Types function allows you to set up codes for the different types of rates
you will be using in the Adagio modules that reference this currency data set.

For example, you may wish to define a daily spot rate to use when entering new
receivables transaction; but you may wish to use a monthly, quarterly, or annual
average rate for certain types of ledger transactions. You can define a rate type for
each of these possibilities.
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Rate Types Process
Step #1: Define the rate type to indicate whether it is a spot or an average rate.

Once the rate type is defined, it is then used in the Currency Tables (Chapter 5) and
Exchange Rates (Chapter 6) functions to indicate the kind of rate that should be used
in the exchange calculations.

Step #2: In Currency Tables, you are required to set up tables for your home
currency; you need to set one table for each home currency/rate type pairing. If you
had three rate types on file, for example, you’d have to have three currency tables.

Step #3: Then, in the Exchange Rates function, the rate type you choose must be one
that is linked to the home currency via a currency table.

Step #4: Outside of Adagio MultiCurrency, the other Adagio modules ask you to
specify a default rate type in their Company Profiles. This default rate type is used
for new multicurrency transactions, but can be changed. It is the rate type you select
in transaction processing that determines what exchange rate while be used for that
transaction.

Rate Types Process
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Creating a Rate Type
To add a new rate type to your system:

1) Select Rate Types from the Edit menu. The Edit Rate Types screen appears. All
existing rate types already on file are listed.

If you have access to the Column Editor, you may change the fields (columns)
that display on this grid. Please refer to the online Help documentation or your
Adagio Fundamentals manual for more information on working with the Column
Editor.

Use the Excel Direct button to quickly export the contents of this grid to an Excel
spreadsheet, assuming Microsoft Excel is installed.

2) Click the New button to add a code. A blank Edit Rate Type window appears:

Creating a Rate Type
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Complete the fields in this window according to the following table:

Field Description

Currency Rate Type Enter two characters for the rate type. This should
be a brief code that is representative of the rate type
itself, such as DS for Daily Spot Rate.

Description Enter a description for the rate type, to a maximum
of 30 alphanumeric characters. For instance, you
might enter “Monthly Average” for a rate type that
is intended to provide the monthly average of an
exchange rate.

3) Click OK to save the rate type, and it will be added to the list.

Creating a Rate Type
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Working with Existing Types
Currency rate types on file can be modified, viewed, copied, or deleted as needed. To
work with codes, select Rate Types from the Edit menu and then use the buttons on
the right side of the window to carry out these functions.

Editing Rate Types
Existing rate types can be modified by selecting the rate type from the list window
and clicking the Edit button; or by double-clicking on the rate type in the list.
However, note that only the description of a rate type can be changed; the rate type
code itself cannot be modified.

Viewing Rate Types
The rate types on file can be viewed in a non-editable window by selecting the rate
type from the list and clicking View.

Copying Rate Types
You can copy a rate type by selecting it in the list, then clicking Copy. Enter a new
two-character rate type when prompted. The description for the rate type can then be
modified, if desired, by editing it via the Edit button.

Deleting Rate Types
If for any reason you find that you do not require a rate type that’s on file, you can
delete it. Just click it once in the list to select it, and then click Delete.

Deleting rate types will also delete all currency tables and currency rates that use that
rate type.

Rate types that are still in use in your Adagio data must not be
deleted, or data corruption will result. Adagio does not check your
data files to see if the rate type you have asked to delete is in use;
you must do that prior to deletion yourself.

Working with Existing Types
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Chapter 5
Working with

Currency Tables

Currency tables dictate the method used to convert a foreign currency into home
equivalent values. Their function is to:

• Couple rate types with your home currency (and possibly other currencies, as
discussed below).

• Set the date method that Adagio will use to choose an exchange rate.
• Indicate whether source currency values should be multiplied or divided by

the exchange rate you provide.
• Indicate the source you use for your exchange rates.

You must set up tables for your home currency. You will need to set up a currency
table for each rate type you plan to use in conjunction with your home currency. If
you have three rate types that you intend to use with the default currency, for
example, you’d have to have three currency tables.

You do not need to create currency tables for foreign currencies, unless:

• you will sometimes be converting one foreign currency to another, or
• you will sometimes be converting the home currency to a foreign currency
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Creating Currency Tables
To add a new currency table to your system:

1) Select Currency Tables from the Edit menu. The Edit Currency Tables screen
appears. All existing currency tables already on file are listed.

If you have access to the Column Editor, you may change the fields (columns)
that display on this grid. Please refer to the online Help documentation or your
Adagio Fundamentals manual for more information on working with the Column
Editor.

Use the Excel Direct button to quickly export the contents of this grid to an Excel
spreadsheet, assuming Microsoft Excel is installed.

Creating Currency Tables
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2) Click New to create a new table. A blank Edit Currency Table window appears:

Use the following table to complete the currency table fields:

Field Description

Currency code Select a currency code for this table. This is the
currency that you wish to specify a conversion
method for, such as your home currency so that
Adagio knows how to convert foreign currencies to
the home currency properly.

Rate Type Choose a rate type to indicate the kind of rate that
should be used when foreign currencies are
calculated to the home currency.

Creating Currency Tables
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Field Description

Description Enter a description for this table. This should be
something that indicates the purpose of the table.
For example, if you’re creating a currency table for
your default currency you might simply indicate
that it’s a “Daily Spot Rate Conversion Table”.

On the other hand, if you’re creating a currency
table for a foreign currency, you will likely want to
specify that currency in the description, since you
won’t have as frequent a need for a foreign
currency table. For example, you could use
something like “CAD Monthly Average
Conversion” to make it easier to separate out tables
for foreign currencies.

Creating Currency Tables
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Field Description

Date Matching When you are entering foreign currency
transactions in Adagio modules, there are occasions
when an exchange rate will not be defined for the
actual date of the transaction or revaluation. In that
case, you need to tell Adagio how to choose an
exchange rate. You do this based on the Date
Matching field.

� If you want Adagio to automatically choose a
rate for the closest date that is earlier than the
transaction/revaluation date, select Lower here.
For example, if you have rates defined for
January 10-15 and January 18, but a transaction
occurs on the 17th, Adagio will choose January
15’s exchange rate.

If there are no rates on file for a date that
precedes the transaction/revaluation date, you
will be prompted to select from a list of dates for
which the rate has been defined for that
currency.

� If you want Adagio to prompt you for a specific
date, select Exact. In this event, when you’re
entering a transaction on a date for which no
rate has been defined, a pop-up window will
appear, asking you to select from a list of
dates/rates.

� If you want Adagio to automatically choose a
rate for the closest date after the
transaction/revaluation occurs, select Higher.
In our January 17th transaction example, that
would cause Adagio to select January 18th’s
exchange rate.

NOTE: If there are no rates file at all, either preceding or
following the transaction/revaluation date, you will be
told that no rates exist and will be required to enter rates
before you can continue.

Creating Currency Tables
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Field Description

Rate Operation Indicate whether the source currency amount must
be Divided by the exchange rate or Multiplied by
it when converting to home equivalent values. This
will depend on your currency information source
and the method they generally use.

Rate Source Specify the name of the source you are using for
your exchange rate information. For example, a
Canadian company might always use the Royal
Bank’s exchange rate data from their web site; so
you could enter Royal Bank Foreign Exchange
here.

You can leave this field blank, if you wish;
however, it is wise to record the source of your
exchange rate data.

Web address If you use a web site to get the latest exchange rate
information, you may wish to specify that web site
address here. By default, Adagio MultiCurrency
enters the web site address from your DataSet
Profile here, but you can change it as needed. (For
more information, see Editing the DataSet Profile in
Chapter 2.)

If you want to go to a web browser to view the URL
that appears by default in this window, or to search
for a more appropriate web site, click the Web
Browse button. (You must be connected to the
internet when you do this.)

You can leave this field blank, if you wish;
however, if you are using a web site to obtain your
exchange rate data, it may be helpful to keep a
record of the URL so you can easily return to it
whenever needed.

3) When you’re finished modifying the currency table fields, click OK to save it. It
will be added to your currency tables list, and can now be used to set up
Exchange Rates, as discussed in Chapter 6.
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Working with Existing Tables
Currency tables on file can be modified, viewed, copied, or deleted as needed. To
work with the tables, select Currency Tables from the Edit menu and then use the
buttons on the right side of the window to carry out these functions.

Editing Currency Tables
Existing currency tables can be modified by selecting the table from the list window
and clicking the Edit button; or by double-clicking on the rate type in the list.
However, note that the currency code and rate type themselves cannot be changed;
only the remaining fields can be modified.

Viewing Currency Tables
The currency tables on file can be viewed in a non-editable window by selecting the
rate type from the list and clicking View.

Copying Currency Tables
If you use the same methods and rate source for converting your home currency to
source currencies regardless of the rate type, you can speed up your work by copying
one currency table, selecting it in the list, and then clicking Copy. Enter a currency
code and rate type for the new table when prompted, and the new currency table will
be created.

The remaining fields in the newly copied currency table can then be modified, if
desired, by editing it via the Edit button.

Deleting Currency Tables
If for any reason you find that you do not require a currency table that’s on file, you
can delete it. Just click it once in the list to select it, and then click Delete.

Deleting currency tables will also delete all rates that use that currency table.

Do not delete currency tables that are used in the Exchange Rates
function. Data corruption may result. Adagio does not check your
data files to see if the currency table you have asked to delete is in
use; you must do that prior to deletion yourself.

Working with Existing Tables
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Chapter 6
Working with

Exchange Rates

The Exchange Rates function is central to multicurrency transaction processing. It is
where you enter and manage exchange rate data so that Adagio knows where to get
exchange rates from, in order to convert foreign currencies to home equivalent
values.
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Creating Exchange Rates
To add a new exchange rate definition to your system:

1) Select Exchange Rates from the Edit menu. The Edit Exchange Rates screen
appears.

All existing rates already on file are listed, showing:

• the home currency;
• the foreign currency that will be converted with the rates you enter under

that exchange rate definition; and
• the rate type that is to be used.

If you have access to the Column Editor, you may change the fields (columns)
that display on this grid. Please refer to the online Help documentation or your
Adagio Fundamentals manual for more information on working with the Column
Editor.

Use the Excel Direct button to quickly export the contents of this grid to an Excel
spreadsheet, assuming Microsoft Excel is installed.

Creating Exchange Rates

Page 6-40 Adagio MultiCurrency



2) Click New to create a new exchange rate definition. A blank Edit Exchange Rate
window appears:

This window has several components.

• The top portion is used to set the home and foreign currencies. The Rate
Type, Date Matching, and Rate Operation fields will be completed
automatically, based on the Home currency you select. It takes this
information from the relevant Currency Table.

• The middle section is used to enter the exchange rates for converting the
foreign currency you chose above to the home currency you selected. It
allows you to add exchange rates for specific dates by using the New
button.

• The final field at the bottom of the window gives you the option to delete
exchange rates before a certain date. You will want to clear out old rates
occasionally, such as after period or year end processing is done, when no
foreign currency transactions remain on file for those periods.

The following steps will provide information on setting the home and foreign
currencies. Then we’ll provide individual sections on adding exchange rates by
date, and on clearing old exchange rate information.

Creating Exchange Rates
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Setting the Home and Foreign Currencies
3) When you’re initially creating an exchange rate definition, you need to indicate

the home and source currencies to which the exchange rates in the mid-section of
this window will apply. Use this table to set up the currency information:

Field Description

Home Currency Use the Finder to select a currency table. This will
automatically enter the Home Currency and the
Rate Type for you.

Or, you can type in the home currency code. This is
the currency to which the values of the Foreign
Currency specified below will be converted, using
the exchange rates/dates you define in this
window.

Rate Type If you used the Finder to select a currency table in
the Home Currency field, the Rate Type will be
automatically completed for you, based on the Rate
Type entered for the currency table.

If you typed in the Home Currency, you will need
to type in or use the Finder to select a Rate Type
here.

The rate type you select must already be linked to
the selected home currency in a currency table, as
the currency table is used to indicate your date
matching and rate conversion methods. If it is not,
Adagio MultiCurrency will not accept your entry.

Foreign Currency Use the Finder to select the foreign currency. This is
the currency whose values will be converted to the
Home Currency, using the exchange rates/dates
you define in this window.

Creating Exchange Rates
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Field Description

Date Matching This field is completed automatically, based on the
Home Currency and Rate Type entered. It uses the
home currency/rate type pairing to get your date
matching preferences from that currency table.

The information provided here is for your
information only; if you want to change the date
matching method, you must do so in the currency
table itself.

Rate Operation This field is completed automatically, based on the
Home Currency and Rate Type entered. It uses the
home currency/rate type pairing to determine
whether the foreign currency amount should be
multiplied or divided by the exchange rate to
return the home equivalent amount.

The information provided here is for your
information only; if you want to change the rate
operation, you must do so in the currency table
itself.

4) When you’re finished setting up the foreign and home currencies, you must
move on to provide exchange rates for this currency conversion. That
information is provided in the next section.
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Enter Exchange Rates
The steps outlined here explain how to add new exchange rates for a foreign to home
currency conversion. This is the process to follow whether you are setting up an
entire exchange rate definition for the first time, as described in the earlier sections of
this chapter, or whether you are simply editing an existing exchange rate definition
to add the latest rate data.

If you are not already in the Edit Exchange Rate window, where you will enter the
exchange rates, simply select Exchange Rates from the Edit menu, double-click on
the home/foreign currency rate you want to add exchange rates for, and the Edit
Exchange Rate window will open.

Enter Exchange Rates
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Now you are ready to add new rates by following these steps:

1) In the lower, right portion of this window, you will see a series of buttons which
can be used to work with your exchange rates. To add a new rate, click the New
button. The Date field will be highlighted, allowing you to add an exchange rate
for the date you specify.

Use the following table to complete the exchange rate options:

Field Description

Date Enter the date for the exchange rate in this field.

During transaction entry in Adagio modules that use this
multicurrency data set, Adagio will try to match the transaction
or revaluation date to a date for which an exchange rate has been
defined here. If it cannot find an exchange rate for a specific date,
it will use the Date Matching setting shown in the top portion of
this window. Date matching is set in the Currency Table; refer to
Chapter 5 for more information.

Enter Exchange Rates
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Field Description

Rate Enter the exchange rate that was/is applicable on the date you
just entered.

For example, if this exchange rate definition is converting
Canadian dollars to US dollars and the Canadian dollar is worth
$0.76 US dollars, you would enter either 0.7570 or 1.3210,
depending on whether your currency table was set up to
multiply or divide the foreign currency value by the exchange
rate (as shown in the Rate Operation field above).

If you want to go directly to the web site you specified in the
Currency Table to view current exchange rate information, click
the Web Browse button. (You must be connected to the internet
when doing so.) Adagio will launch a browser window and open
the site indicated to the left of the Web Browse button, allowing
you to peruse current exchange rate information.
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Field Description

Spread When transactions are entered or accounts are revalued in other
Adagio modules, the exchange rate field is set based on the
transaction/revaluation date. However, it can be overridden.

The spread you enter here will put a limit on how much the
exchange rate can be modified. For example, if someone is
entering a transaction and overrides an exchange rate of 0.7396
by entering 0.5496, that may be a clerical error and is likely to be
an unacceptably large jump in the default exchange rate for that
date.

To prevent errors or problems when overriding exchange rates
during transaction entry or revaluation, you can set an
acceptable” range” of rates with the value you enter in the
Spread field.

The value you enter here will be added to and subtracted from
the day’s rate to create an allowable spread. For instance, if the
exchange rate is 0.7396 and you want to allow that to be
overridden by up to one cent in either direction, you would enter
0.1 here. Then, any exchange rate entered for this date will be
allowable if it falls between the range of 0.7296 and 0.7496. If it
falls outside of that allowable spread, then Adagio will issue a
warning to indicate that the exchange rate entered is outside of
the spread.

If you always want to be warned when the exchange rate is
overridden by any amount, enter 0.0 in this field.

If you never want to be warned, enter a very large number
instead.

2) When you’re finished entering the date, exchange rate, and spread, click Add.
The exchange rate for the specified date will be added to the list in the lower
portion of this window.

3) The Auto Add feature will automatically move the cursor back into the Date
field to let you add another date and rate.

• To add another rate, repeat steps 1-2 above.
• If you don’t want to add another rate, click Cancel.

4) When you’re finished adding all of the rates you want, click Done to exit.
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Deleting Outdated Rates
The final field at the bottom of the Edit Exchange Rate window gives you the option
to delete exchange rates before a certain date. You will want to clear out old rates
occasionally, such as after period or year end processing is done, when no foreign
currency transactions remain on file for those periods.

To delete rates:

1) If you are not already in the Edit Exchange Rate window, select Exchange Rates
from the Edit menu, double-click on the home/foreign currency rate you want to
add exchange rates for, and the Edit Exchange Rate window will open.

In the date field that appears at the bottom of this window, select a date. All
rates up to and including this date will be deleted when you click the button to
the left.

Deleting Outdated Rates
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2) When you’ve set your date and are ready to delete your old rates, click Delete
Range. You will be asked:

3) Click Yes, and the rates will be deleted.

Deleting Outdated Rates
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Working with Existing Rates
The exchange rates you’ve set up can be modified to add new rates; or viewed,
copied, or deleted as needed. To work with the exchange rates, select Exchange
Rates from the Edit menu and then use the buttons on the right side of the window
to carry out these functions.

Editing Exchange Rates
Existing exchange rates can be modified by selecting the table from the list window
and clicking the Edit button; or by double-clicking on the rate type in the list.

The top portion of the window cannot be modified, but new rates can be added. See
the section on Defining Exchange Rates, earlier in this chapter, for more information.

Viewing Exchange Rates
The exchange rates on file can be viewed in a non-editable window by selecting the
exchange rate from the list and clicking View.

Deleting Exchange Rates
If for any reason you find that you do not require a exchange rate that’s on file — for
example, if you no longer sell product in a particular foreign country — you can
delete it. Just click it once in the list to select it, and then click Delete.

Be very careful not to delete exchange rates for currencies that you
still work with. If you do so, Adagio will not know how to convert
the foreign currencies into home equivalent amounts.
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Chapter 7
Printing Reports

Adagio MultiCurrency includes several reports that you can print if you want to
keep hard copies of your currency settings, exchange rates, and so forth.

All Adagio modules include the same basic features for printing reports. For more
information on printing reports and setting report options, please refer to your
Adagio Fundamentals manual.

Adagio MultiCurrency does not support the Custom Reports
functionality described in Fundamentals, however; nor does it
allow for faxing of reports.

This chapter will describe the purpose of each of the Adagio MultiCurrency reports
specifically, and will explain any special options that pertain to these reports.

DataSet Profile Report
This report will print a copy of your DataSet Profile information.

To print this report, select it from the report menu and click Print.

Currency Codes Report
This report will print a listing of your currency codes and their settings, in the range
you specify. To print all currency codes, accept the default range.

To print this report, select a range of currency codes and click Print.
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Rate Types Report
This report will print a listing of your rate types codes and their descriptions, in the
range you specify. To print all rate types, accept the default range.

To print this report, select a range of rate types and click Print.

Currency Tables Report
This report will print a listing of your currency tables and their settings. You must set
the range of currencies to include on the report, as well as the range of rate types. All
currency tables that fall within those parameters will be included on the report. To
print all currency tables, accept the default ranges.

To print this report, select a range of rate types and click Print.

Currency Rates Report
This report will print a listing of your exchange rates. You must set the range of
currencies to include on the report, as well as the range of rate types. To print all
exchange rates, accept the default ranges.

You may also want to note these options:

• Date ranges: If you wish to print all exchange rates on file but limit the date
ranges for the rates that will be included, you can set a date range using the
calendar buttons to the right of the Date fields.

• Page break option: This report also includes a checkbox which allows you to
insert a page break between home currencies. If you turn this on, if the home
currency changes on the report, Adagio MultiCurrency will automatically
insert a page break for you. This may make it easier when you are trying to
separate out different currencies and exchange rate listings.

When you’re ready to print this report, click Print.
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Appendix A
Adagio Ledger

Adagio Ledger allows you to work with multiple currencies through several special
features, which are discussed in the following chapters.

This chapter covers multicurrency-specific functions. You may want to refer to the
Adagio Ledger manual for some basic information as needed.
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Activating MultiCurrency
There are two basic steps in activating multicurrency for use in a particular Adagio
Ledger database:

1) Set up your currency information in the Adagio MultiCurrency module.

2) Turn the multicurrency option on in the Company Profile in Adagio Ledger and
set some defaults for multicurrency processing.

The following sections explain each of these steps.

Adagio MultiCurrency
Most of your multicurrency setup will be done in the Adagio MultiCurrency module,
which allows you to set up currency codes, rate types, and other data.

Information on working with the MultiCurrency module can be found in the Adagio
MultiCurrency manual or help file.

There is one area of overlap between Adagio MultiCurrency and Adagio Ledger:
currency codes. Adagio Ledger’s File | Currency Codes function interfaces with
Adagio MultiCurrency such that if you create or modify a currency code in one
module, it will appear in the other module for the same data set. Currency code
editing is documented in the Adagio Fundamentals manual or in your Adagio
Ledger help file.

Activating MultiCurrency
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Editing the Company Profile
The Company Profile includes a multicurrency flag, which turns multicurrency on
for the database.

To activate multicurrency:

1) Select Company Profile from the Edit menu, or click the Profile button on the
Toolbar. The Company Profile screen appears with the Company Data tab in
front.

2) Turn the Use multicurrency? checkbox on if you want this data set to be able to
read in, post, and process data from multiple currencies. When you turn this
option on, certain fields and functions specific to multi-currency data sets will
become available to you.

Once you turn the multicurrency option on, you cannot turn it off
again. You may choose not to use the multicurrency functions in the
future, but you cannot simply turn it off at a future date.

3) This tab also specifies the Home currency, which is the default currency code
you’ve set up in Adagio MultiCurrency or Adagio Ledger’s Currency Codes
function.

4) In the Default rate type field, select your preferred default rate type for use in
Ledger. It should be the rate type you use most often. However, the default rate
type can be changed as needed when you are editing batches and so forth.

Activating MultiCurrency

Adagio Ledger Page A-55

Multicurrency
flag

Note



5) Rate types are set in the Adagio MultiCurrency module; for more information
rate types, you should refer to the Adagio MultiCurrency manual or help file.

6) Click OK to save the multicurrency settings in your Company Profile.

Once you have set these options in your Company Profile, you are ready to begin
working with Adagio Ledger’s multicurrency functions.

Activating MultiCurrency
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Revaluation Codes

Revaluation Overview
Because currency rates fluctuate, certain types of accounts may need to be revalued
from time to time to reflect the company’s true financial status. Generally, you would
want to revalue accounts prior to printing financial statements.

When accounts are revalued, the gain or loss on the account’s value will be written to
an unrealized gain or loss on exchange account. When transactions are completed,
such as outstanding receivables being received, that previously unrealized gain or
loss will then be reversed and written to a realized gain or loss on exchange account.

Some sample accounting entries of this process can be seen in the Revaluation
Example topic.

You must have active accounts for Gain/Loss on Exchange Rate (income statement
account) and Unrealized Gain/Loss on Exchange Rate (balance sheet account) set
up in your Ledger before you can properly use multiple currencies and do
revaluations. See your Adagio Ledger manual for information on setting up
accounts, if needed.

The Process
The revaluation process is fairly straightforward.

1) Create a source code to be used for revaluation transactions; something like
GL-RV to indicate that the transaction originated in the GL and that it was a
revaluation. See your Adagio Ledger manual for information on creating source
codes.

2) Create revaluation codes. These codes, which will be assigned to the accounts
that should be revalued regularly, will indicate several things:

• When the Revalue Accounts function is run, the revaluation code for the
account will indicate whether the current balance of the account should be
revalued, or whether only net changes to the account (since the last
revaluation occurred) should be revalued.

• What rate type (as set in the Adagio MultiCurrency module) should be used
when accounts are revalued. When the Revalue Accounts function is run, the
rate type will dictate the default exchange rate and rate date to be used for the
revaluation. It can be changed at that time, but normally you would assign one
rate type and use that regularly for revaluations.

• What source code should be used.
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• Finally, what account/department should be used for the unrealized gains
and losses on the account.

The following sections in this chapter will explain how to set up your
revaluation codes.

3) Using the Edit Accounts function, indicate which accounts should be revalued.
Accounts should generally only be revalued if they are monetary accounts such
as your bank and cash accounts, or payables and receivables accounts. Other
types, such as inventory accounts, should not be revalued.

Complete information on flagging your accounts for revaluation described in
Chapter 4.

4) After ensuring that your exchange rates are up-to-date, run the Revalue
Accounts function. Accounts will be revalued to properly reflect the company’s
current financial status, given their multicurrency receivables and payables.

The Revalue Accounts function is described in detail in Chapter 6.

Revaluation Example
As discussed earlier in this chapter, when accounts are revalued, there are both
realized and unrealized gain/loss on exchange accounts that are affected.

To illustrate how this works, we’ll use a simple example: Assume that a Canadian
company takes an order from a US customer in the amount of $100.00. At the time of
the purchase, the exchange rate makes that $100 US worth $150 Canadian. However,
a month later when the US customer pays their invoice, the value of the sale has
dropped to $135 in Canadian dollars.

The Realized Gain/Loss on Exchange account is an income statement account. The
final balance of this account is combined with the value of your revenue account on
the income statement to represent the final value of the sale in Canadian dollars.

The Unrealized Gain/Loss on Exchange account is a balance sheet account. When
the order is placed, this account gets debited by the $50 difference between the US
price and the initial Canadian value of the order. Later, when the payment is
received, this account gets credited the $50 to return its value to zero. That is when
the gain or loss is realized and gets written to the income statement account.
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The accounting transactions for this example would be as follows:

On the day the order is placed:

Debit Credit

US dollar Receivables
(equivalent to

100.00 US
150.00 CAD)

Sales
(equivalent to

150.00 CAD
100.00 US)

On the day the payment is received:

Debit Credit

Bank
(equivalent to

135.00 CAD
100.00 US)

US dollar Receivables
(equivalent to

100.00 US
150.00 CAD)

Realized Gain/Loss on Exchange 15.00 CAD

At the end of the transaction:

• The Realized Gain/Loss on Exchange account has a debit balance of 15.00
(150.00 - 135.00 CAD).

• The Sales account has a credit balance of 150.00 CAD.
• The Bank is debited with the receipt of the sale, 135.00 CAD, reflecting the

final amount that the company actually earned given the exchange rate on the
US dollar purchase at the time the payment is received.

Only cash is realized. Credit notes, debit notes and adjustments are
unrealized and, therefore, not affected by revaluation.

Creating Revaluation Codes
Adding revaluation codes is a necessary step when you are working with multiple
currencies and wish to ensure that your outstanding payables and receivables are
valued at the current exchange rate prior to printing financial statements.
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To add new revaluation codes:

1) Select Revaluation Codes from the Edit menu. The following window appears:

2) To add a new code, click the New button. When you do so, the following
window appears.
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Using the information in the following table, complete the fields for the new
revaluation code:

Field Description

Revaluation code Enter the short code (maximum six
characters/numbers) in this field and then a description
of the code in the field to the right. If you want to see
what other codes you have on file, click the Finder
button.

NOTE: When editing a revaluation code, the code and its
description will appear here automatically, depending on
which one you selected. The code cannot be changed in the
edit mode; however, the description can be modified at any
time.

Revaluation type The revaluation type allows you to indicate whether
you wish to revalue currency balances or the net
changes only. Generally, you will want to revalue
Current balances for balance sheet accounts (such as
receivables) and retained earnings accounts, while
selecting Net changes for income statement accounts
(such as revenue).

Rate type Indicate the exchange rate type that you wish to use
when revaluing this account. This refers to the rate
types set up in your Adagio MultiCurrency module. See
the Adagio MultiCurrency manual or help file for more
information.

You can click the Finder button to view and select from
a list of the possible rate types.

Source code Choose a source code to be used for revaluations. You
may want to enter something like GL-RV as the source
code, indicating that the transaction originated in the
GL and that it was a revaluation.

Revaluation Codes

Adagio Ledger Page A-61



Field Description

Unrealized exchange
gain/loss

As discussed in the Revaluation Overview earlier in this
chapter, you need to specify an account to which
unrealized gains or losses will be applied. This is the
account that will show changes in a transaction’s value
due to exchange rates, going up or down as exchange
rates fluctuate. You should already have set this up in
your chart of accounts, so just use the Finder button to
select the appropriate account (and department, if
applicable).

3) When you have completed the revaluation code information, click OK to save
the code.
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Setting Up Accounts
The Accounts function in Adagio Ledger includes a multicurrency option which,
when turned on, creates an extra Currency Details tab for the account This section
explains how to set up the account’s currency information to let Adagio Ledger know
how to process transactions properly.

Multicurrency Account Options
To turn an account’s multicurrency option on and set up its currency information:

1) Select Accounts from the Edit menu, or click the Maintain button on the Toolbar.
The Edit Accounts screen appears.

2) Double-click the account you want to activate multicurrency options for, such as
a receivables account, to open it for editing. The account window appears:

3) In the General tab, turn the Multicurrency checkbox on. You will see a Currency
Details tab appear for the account.
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Once you turn the Multicurrency option on for an account, you
cannot turn it off again.

4) Click the Currency Details tab to bring it to the front.

Edit the first two fields in this window according to the information in the
following table:

Field Description

Post in This option determines whether you can post to this
account in all of the currencies specified in the Currency
function, or whether you can only post to this account in
the currencies you choose here.

If you wish to be able to post to this account in all
currencies, select the All currencies radio button.

If you wish to post to this account only in the currencies
you choose, select the Specified currencies radio button
instead. In this case, you will have to indicate the
currencies that are allowable for this account.
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Field Description

Default currency Use this field to indicate the default currency you wish
to use for this account. Click the Finder field to view the
complete list of currencies.

NOTE: If this currency is anything other than Home
currency, it must be listed in the Source Currency grid
below.

5) Next, you need to add one or more source currencies for this account.

To add a source currency for this account, click the New button. Doing so
activates the fields in the Account Source Currencies section of this window.

Use the following table to complete the fields for the source currency:

If your account type is set to Retained earnings in the General tab,
you must include the home currency when adding source currencies
for this account.

Field Description

Source currency To allow users to post to this account in a specified
currency, select the currency of interest here.

Revalue? If you wish to be able to revalue the account balances in
this currency when you run the Revalue Accounts
function, turn this option on.

Accounts should generally only be revalued if they are
monetary accounts such as your bank and cash
accounts, or payables and receivables accounts. Other
types, such as inventory accounts, should not be
revalued.

NOTE: In the case of Receivables and Payables control
accounts, Adagio Payables 8.0 and Adagio Receivables 8.0
have their own revaluation functions and therefore can be
omitted from revaluation in the Ledger module.

Revaluation is explained in more detail in Chapters 3
and 6.
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Field Description

Revaluation code If you have turned the Revalue? checkbox on, you will
need to specify a Revaluation Code here.

Once you’ve completed the fields for a source currency, click Save to add it to
the currency list at the bottom of the window.

6) Repeat step 5 for each source currency you want to add for this account.

7) If you need to go back and edit a source currency you’ve added, select it in the
list at the bottom of the window by clicking it once, and then click the Edit
button. You would also delete a source currency in the same way.

8) Click OK to save the changes to the account.

Repeat steps 2-7 for each account you want to use multicurrency data with.

When you’re finished setting up your accounts, you’re ready to begin processing
multicurrency transactions in Adagio Ledger.
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Working with Transactions
There are two aspects of transaction processing that are affected when you are
working with a multicurrency data set. These are:

• Entering and editing batches
• Retrieving batches from your subledgers

This section will explain the multicurrency options that impact these functions.

Entering and Editing Batches
Batch entry is discussed fully in the Adagio Ledger manual, which can be referred to
for basic batch entry information. In this section, only those fields and options that
pertain to multicurrency will be explained.

When adding or editing a batch, only the detail line window will include
multicurrency options. This is the window that appears when you are editing
individual lines/details in a batch. To get to that window, follow these steps:

1) Select Batches from the Edit menu. The Edit Batches window appears. Existing
batches are listed in the window.

2) Select the batch to edit by clicking on it and click the Edit button; or create a new
batch by clicking New. The Batch window appears.

3) Select a batch entry to edit by clicking on it and click the Edit button; or create a
new entry by clicking New. The Batch Entry window appears.

4) Select the line to be edited by clicking on it and click the Edit button; or create a
new detail line by clicking New. The Line window appears. This is the window
that includes the multicurrency fields.
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Multicurrency Options in the Line Window
The Line window during batch entry includes several multicurrency fields:

Use the following table to complete these fields for each line you’re adding or
editing:

Field Description

Source currency When you select an account that allows multiple
currencies (as discussed in Chapter 4), you will have the
option to choose a source currency for this detail line.
Your options will be limited only to those currencies
that the Account is set up to accept.

By default, the source currency displayed here will be
the default currency that was set up for that account. To
choose a different currency, click the Finder button and
select the source currency of interest.

If you have chosen a currency other than the home
currency, the Rate type and Rate fields will become
active and should be edited.
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Field Description

Rate type If you have chosen a source currency other than the
home currency, this field can be edited. Use this field to
indicate the rate type you prefer. This dictates the
exchange rate that will be entered in the Rate field and
used when converting the value entered for this line
into the home currency.

Rate types are set up in the Adagio MultiCurrency
module. For more information on setting up and
modifying the rate types, see your Adagio
MultiCurrency manual or help file.

Rate If you have chosen a source currency other than the
home currency, this field can be edited.

By default, this field will contain the exchange rate that
the Rate type dictates. Normally, you will not want to
modify that rate. However, there are special
circumstances which may apply to single transactions,
such as the bank giving you a better rate for transferring
large sums of money between two different currency
accounts. In this event, you can override the exchange
rate entered as needed.

Rate date When you select a Rate type for this line, Adagio
Ledger will enter the exchange rate and date that the
rate type dictates. The date cannot be edited; it simply
shows you the date that the rate type is using.

Rate types are set up in the Adagio MultiCurrency
module. For more information on setting up and
modifying the rate types, see your Adagio
MultiCurrency manual or help file.

Source and Home
Debits/Credits

You have the choice to enter debits or credits for this
line in either the source or the home currency. The
exchange rate specified in the Rate field will then be
used to automatically complete the other field.

As with normal batch entry and editing, once you’re finishing modifying the detail
line, click OK to save it.
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Retrieving Subledger Batches
Retrieval of subledger batches is essentially the same for either single or multiple
currency data sets.

The only time there is a difference is when you have multicurrency subledgers, such
as Adagio Payables and Adagio Receivables, but a single currency Ledger. In that
event, all multicurrency subledger transactions that are retrieved will be converted to
the home currency using the exchange rate indicated for the individual transactions’
rate type.
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Revaluing Accounts
As explained in the Revaluation Overview in Chapter 3, because currency rates
fluctuate, certain types of accounts may need to be revalued from time to time to
reflect the company’s true financial status. Generally, you would want to revalue
accounts prior to printing financial statements.

To revalue accounts:

1) Select Revalue Accounts from the Maintenance menu. The following window
appears.

2) Click New to specify a currency to revalue. When you do this, the fields at the
top of the window will become active. You can use these fields to narrow the
range of accounts that should be revalued and so forth.
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Use the table below to complete the revaluation options.

Field Description

For currency Specify which currency you wish to revalue. All
transactions entered in this currency, for the account
ranges and other selection criteria you indicate in the
following fields, will be revalued when you click the
Revalue button.

Account

Department

Indicate the range of accounts and departments you
wish to include in this revaluation.

Only accounts that have been flagged as multicurrency
accounts that can be revalued will be revalued, so if you
want to revalue all accounts, just accept the defaults;
those accounts that aren’t flagged for revaluation will be
bypassed in the process.

NOTE: See Chapter 4 for more information on setting up
accounts to allow multicurrency transactions.

Period Enter the range of periods to include in the revaluation.
Only the transactions in the period range you enter will
be revalued.

For revaluation code Indicate the revaluation code that should be used to
revalue this currency. This will tell Adagio Ledger
whether to revalue amounts based on currency balances
or net changes in the accounts’ values; and other
important information. (See Chapter 3 for more
information on setting up revaluation codes.)

Date This field defaults to the date you entered when you
logged in to Adagio Ledger. You can change it if you
wish to select a different date to be used to determine
the exchange rate.
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Field Description

Rate When you set the revaluation code to be used for this
currency, the rate type that was assigned to that
revaluation code will dictate what exchange rate and
rate date is used in the revaluation, and will enter that
information in the Rate and Rate date fields. You can
overwrite the rate if desired, but generally you will
want to accept the rate information entered.

Note that if you do overwrite the rate itself, the Rate
date won’t change.

Rate date When you set the revaluation code to be used for this
currency, the rate type that was assigned to that
revaluation code will dictate what rate and
corresponding rate date should be used. If you do
overwrite the rate itself, the Rate date won’t change,
and cannot be edited. This will allow you to check the
exchange rate at the time of revaluation later if you’re
using a rate that differs from the default rate provided
for the appropriate rate date.

When you’re finished editing the options, click OK to save that currency in the
list at the bottom of the window.

3) Repeat step #2 for each currency you wish to revalue at this time.

4) Your currencies and applicable selection criteria (account ranges, periods, and so
forth) will be listed in the grid at the bottom of this window.

If you see that you’ve made a mistake and need to edit something, click on that
currency once to select it, then click the Edit button. Or, if you need to delete a
currency to prevent it from being revalued at this time or to re-enter its details,
select it and then click Delete.

5) When you’ve entered all currencies you wish to revalue, and their selection
criteria, click Revalue to proceed. Adagio Ledger will revalue all of the entries
for that currency in the account, department, and other ranges specified, and
then will let you know that the revaluation is complete. It will advise you that
the ledger entries for the revaluation have been written to a specific batch
number. (The batch will be titled “Revaluation batch”.) You can then open that
batch for review/editing as needed.
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Miscellaneous Features
Some of Adagio Ledger’s core functions include extra options for multicurrency data
sets. Specifically:

• Display Accounts includes an extra Balance button which lets you view
account balance information in a multicurrency format. The Transactions
window also includes some extra multicurrency information.

• Edit Account History and Edit Account Budget allow you to view data for the
account master or for specific currencies.

• The program Options let you set a specific printer to be used for
multicurrency reports.

• Several reports include source currency and home equivalent options.

This section outlines the multicurrency-specific options for these functions in more
detail.

Displaying Accounts
In the View Transaction/Budgets function, there is one completely separate
multicurrency option for multicurrency account data which does not appear at all in
single currency Ledgers, the Balances button. In addition, the Budget/History button
separates out currency data or displays the account master data in multicurrency
data sets. We’ll discuss each of these buttons in turn.

Displaying Account Balances
To view the account balance information, broken down by source currency:

1) Go to the View Tansaction/Budgets function (Inquiries menu) and select the
account of interest by clicking it once.
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2) Select the Balances button. The Display Account Balances window appears.

This window lists a breakdown of the source currencies for which data appears
in the selected account and fiscal period, providing a total balance for each
currency and then displaying the equivalent balance when converted to the
home currency.

3) You can scroll through accounts using the Previous and Next buttons, or select a
specific account in the Account field using the Finder button. You can also
specify the fiscal period of interest.

Displaying Budget/History Data
To view the budget/history information by account master or for a specific currency:

1) Go to the Display Accounts function (Maintenance menu) and select the
account of interest by clicking it once.
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2) Click the Budget/Hist. button. The Display Account Budget History window
appears.

3) In the Budget history for field, indicate whether you wish to view the budget
history for the account master (the total budget in the home currency), or for a
specific currency.

If you select a specific currency, only the values budgeted for that currency will
be displayed.

4) You can scroll through accounts using the Previous and Next buttons, or select a
specific account in the Account field using the Finder button. You can also
specify the fiscal period of interest.

Editing Account History
The Account History function works in a very similar manner for both single and
multiple currency databases.

The primary difference is that in a multicurrency database, you have the option to
select a specific source currency whose history you wish to edit; or, you can edit the
Account master’s history — that is, the totals for the account.

You can view complete information about the Account History function in your
Adagio Ledger manual; here we’ll highlight the multicurrency-specific features of
this function.
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To edit account history for a multicurrency data set:

1) Select Account History from the Edit menu. The Edit Account History window
appears.

2) Select the account of interest by clicking on it.

3) Click View to review the account history without editing it. Click Edit to make
changes. The Account History Details window appears.

4) In the Edit history for field, select a specific source currency whose history you
wish to edit; or, you can edit the Account master’s history — that is, the totals for
the account.

When you select a specific currency here, rather than the Account master, you
will be editing the net change or balance information, by fiscal period, for only
that currency. The changes you make will then be reflected in the Account master,
of course.

5) You can choose to edit the information for a particular currency in either the
source currency values, or in the equivalent home currency values. This extra
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option, the Type field, appears only when you have selected a currency in this
field; it does not apply when you choose to edit the Account master.

6) Make the required changes, then click OK to save the changes.

Editing Budget Data
The Budget Data function works in a very similar manner for both single and
multiple currency databases.

The primary difference is that in a multicurrency database, you have the option to
select a specific source currency whose budget you wish to edit; or, you can edit the
Account master’s budget — that is, the total budget data for the account.

You can view complete information about the Budget Data function in your Adagio
Ledger manual; here we’ll highlight the multicurrency-specific features of this
function.

To edit budget data for a selected multicurrency-enabled account:

1) Select Budget Data from the Edit menu. The Edit Account Budget Data screen
appears. It lists all the accounts in your system.
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2) Select the account for which you want to edit budget data by clicking on it. Click
the Edit button. The Budget Data window for that account appears.

3) For multicurrency-enabled accounts, you can use the Edit Budget for field to
indicate whether you wish to edit the budget data for the account master, or for
any of the specific currencies that the account has been set up to allow.

If you want to work with the overall budget data for this account (totals
presented in the home currency), you can select Account master here. Or, to
work with a specific currency’s budget data for this account, choose that
currency in the drop-down box.

4) When you choose a specific currency, an additional field appears to the right,
asking you to indicate the currency Type. If you select Source currency, you will
be working with values in the selected currency itself. If you choose Home
equivalent, you will be working with values that are equivalent to the home
currency; that is, you should be entering the values as if the exchange rate has
already been applied.

5) Select the update method from the pull-down list in the Update budget by field.
The options are the same as for a single currency data set, with one exception.

When you choose to update by budget by Moving values, you have several
different options. The Moving values selection allows you to take the actual
dollar values for this account and “move” them into the budget for the coming
year, either as is or by adjusting them in a particular way.

First, you must edit the from inquiry account field to specify which set of values
you wish to move. You can move the data for the Current or Prior year — what
actually happened in that account for the selected year, regardless of budgeted
values — or you can move the values that were assigned as the Budget for the
current year.

From there, you have to indicate whether you wish to move the current, prior, or
budget values as is or by adjusting them in some way.

The following options, listed in the by drop-down field, are specific to
multicurrency data sets:

• Multiplying by exch. rate: This option should not be used if you’re editing
budget data in the Home equivalent for this currency (see the Type field at
the top of the dialog box). When you are editing budget data for the source
currency, this option allows you to take the values you are moving from the
current, prior, or budget columns and multiply them by a particular exchange
rate. You would generally want to take an average exchange rate value and
apply it here, instead of taking a low or high exchange rate for this currency.

When you choose this option, you will be required to enter the exchange rate
that should be used for the multiplication, and then indicate whether you
want to replace the budget values entirely, using the Replace budget option;
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or add the multiplied values to the existing values in the current, prior, or
budget columns using the Accumulate budget option.

• Dividing by exch. rate: This option works on the same principle as
Multiplying by exch. rate, described above, except that the current, prior, or
budget column values will be divided by the exchange rate you enter, rather
than multiplied by it.

6) Make your desired changes to the account’s budget data, then click OK to
recalculate the budget and return to the Edit Account Budget Data screen.

Program Options
Some specific printing options are available for multicurrency databases in Adagio
Ledger’s Options function.

To view and edit the multicurrency printing options:

1) Select Options from the File menu. The Option window appears.

2) The bottom of the window includes a section titled MultiCurrency Report
Printer. You can print your multicurrency reports to your default printer (as set
up in your Windows Printers function), or to a specific printer.

If you choose the Specific option, click the down arrow to select a printer from a
list of installed printers.
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3) Whether or not you are sending your standard reports and your multicurrency
reports to the same printer, you can also indicate a specific Paper tray that
should be used for your multicurrency report printing.

Since multicurrency reports are usually printed in landscape mode as they
contain more data, it may be useful to print these reports to legal-sized paper or
something other than your standard report paper. If you want to select a
different paper tray, just click the down arrow and select one of the paper tray
options for your printer.

4) Click OK when you have finished setting options.

Multicurrency Reporting

Source vs. Home Currency Reporting
Two Adagio Ledger reports include an option to print only home currency/home
equivalent values on the report or posting journal, or to include both the source
currency values and the home currency values.

The reports that include this capability are:

• Source Journals
• Detail Listing

When printing these reports, simply indicate your preference regarding the home
equivalent or source currencies.

Revaluation Codes Report
Printing a Revaluation Codes report is the same as printing any other standard report
in Adagio Ledger. You can find general report printing options for Adagio in the
Adagio Fundamentals manual.

To print this report, which lists the revaluation codes in the range you specify, along
with their respective settings, simply select Revaluation Codes from the Reports
menu.
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Chart of Accounts Report
The Chart of Accounts report is very similar for both single and multiple currencies
data sets. The only difference occurs if you select Budget/history as your report style.
When you do so, you have some multicurrency-specific options in the
Budget/History Format section of this window.

In this section, indicate whether you want the report to include All budget/history
data, or any combination of:

• Account master: Totals for the account budget/history, including home
currency values and other currencies that have been converted to the home
equivalent but shown as one value rather than separated out.

• Source currencies: Budgeted or history values separated out by source
currency.

• Home equivalents: Budget/history values that are separated out by source
currency, but are displayed on the report in the converted home currency
equivalent.

You can select any combination of the above three items, or simply select All to
include everything.
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The remainder of the report options are the same as they are for a single currency
data set.

Importing & Exporting
If you have already created a file that contains source currency information for your
accounts, using a spreadsheet, database or other financial data program, you can
import that file directly into Adagio Ledger. The account numbers used must exist in
the Adagio Ledger database already; the data about the source currencies will simply
be applied to the account numbers specified in the import file.

The information that can be imported for source currencies is the same information
that appears in the Currency Details tab of the account editing function, as described
in Chapter 4.

To import source currencies:

1) Select Import - Source Currencies from the File menu. The Import Source
Currencies window appears.

2) Choose an import template.
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An import template is a list of import settings. If you regularly import source
currency data using the same settings, you can set up a template. Then when you
want to import source currency data using those settings, you simply need to
select that template. To choose an import template click the down-arrow button
and select a template from the list of available templates.

You can also use the buttons to the right of the template list to create new
templates or save changes to existing ones.

You cannot save changes to the default template; however, you can
modify it and save the changes under a new template name.

3) Complete the File Information tab, which allows you to select the file type and
file name to be imported and to set certain import option, according to the
options on the following table.

Field Description

File format Select a file type to import based on the source
application.

File name Enter the path (drive and directories) and file name of
the source currencies to be imported. You can click the
button to select from a list of files.

Header included? Check this box to import header information for the
batch.

Overwrite records? Check this box if you want the imported source
currencies to overwrite any existing source currencies
with the same numbers in your database.

Add new records? Check this box to add new source currencies to your
system if they do not already exist.

Validate before
importing?

Check this box to perform a validity check of all
imported source currencies. If selected, the system
checks for existing records, checks the validity of all
coded values, and checks that all imported data is valid
(dates, numbers in ranges, etc.). Note that if you select
to perform validity checks the import process will be
much slower.

Separator Enter a character to use as a separator for the data.
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Field Description

Use 4 digit years? Check this box to use a four-digit year format, otherwise
the system will default to using a two-digit year format.

Use extended
character set?

If your import file contains characters in the extended
character set, such as French accented characters, be
sure to turn this option on. When this option is
activated, those characters will be imported properly.
When the option is turned off, the imported record will
simply be halted or skipped, depending on whether you
have turned this option on or not.

4) Click on the Import Field Selection tab.

To use this tab:

• Select a field from the Available fields list by clicking on it.

• Click the right arrow button to move it into the Selected fields list.

You can remove a field from the Selected fields list back to the Available
fields list by clicking on it and then clicking the left arrow button.
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• Continue moving fields until all desired fields are listed in the Selected fields
list. You can use the double right arrow button to move all fields or the double
left arrow button to move them back.

Click the Filler button to add a filler for the selected field. Fillers are used to
allow for imported or exported fields that are not available in the Available
fields list.

• Sort the fields in the Selected fields list (first on top, last on bottom) by
selecting an option and then moving it up one position in the list by clicking
the up arrow button, or moving it down one position on the list by clicking the
down arrow button.

The properties for the fields to be imported are indicated at the bottom of the
screen.

5) Click on the Field Defaults tab.

To use this tab:

• Select a field for which you want to set a default from the Fields not imported
list by clicking on it.

• Click the right arrow button to move it into the Defaulted fields list. You can
remove a field from the Defaulted fields list back to the Fields not imported
list by clicking on it and then clicking the left arrow button.
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• Continue moving options until all desired options are listed in the Defaulted
fields list.

• Set the properties for the fields to be imported by completing each field at the
bottom of the window.

6) Click Import when you have completed all of the fields to import the source
currencies as specified. When you do so, the source currencies will be imported
and you will be told how many records were added, ignored, or had corrupt
data and could not be imported.

Exporting Source Currencies
You may, on occasion, wish to export your source currency data to another
application such as a spreadsheet or another data set.

The source currency data that gets exported is the information that appears on the
Currency Details tab in the account edit function, along with the account number
and department.

To export your source currency information:

1) Select Export - Source Currencies from the File menu. The Export Source
Currencies window appears.
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2) Choose an export template in the top of the window.

An export template is a list of export settings. If you regularly export source
currency data using the same settings, you can set up a template. Then when you
want to export source currency data using those settings, you simply need to
select that template. To choose an export template click the down-arrow button
and select a template from the list of available templates.

You can also use the buttons to the right of the template list to create new
templates or save changes to existing ones.

You cannot save changes to the default template; however, you can
modify it and save the changes under a new template name.

3) In the File Information tab, complete the following fields:

Field Description

File format Select a file type to export based on the destination
application.

File name Enter the path (drive and directories) and file name of
the source currencies to be exported. You can click the
button to select from a list of files.

Header included? Check this box to export header information for the
source currencies.

Overwrite existing
file?

Check this box if you want any existing file in the path
and of the name you specified to be overwritten.

Separator Enter a character to use as a separator for the data.
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4) Click on the Field Selection tab to select the source currency fields to be
exported.

To use this tab:

• Select a field from the Available fields list by clicking on it.

• Click the right arrow button to move it into the Selected fields list.

You can remove a field from the Selected fields list back to the Available
fields list by clicking on it and then clicking the left arrow button.

• Continue moving fields until all desired fields are listed in the Selected fields
list. You can use the double right arrow button to move all fields or the double
left arrow button to move them back.

Click the Filler button to add a filler for the selected field. Fillers are used to
allow for fields that are necessary in the destination file/application but are
not available in the Available fields list.
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• Sort the fields in the Selected fields list (first on top, last on bottom) by
selecting an option and then moving it up one position in the list by clicking
the up arrow button, or moving it down one position on the list by clicking the
down arrow button.

The properties for the fields to be exported are indicated at the bottom of the
screen.

5) Click Export when you have completed all of the fields to export the source
currencies as specified. When you do so, the Export screen appears:

Complete each field using the following table:

Field Description

Export by Choose to export the data sorted by
account/department and then by source currency, or by
source currency and then account/department.

Export figures as Choose to export figures by net changes or balances.

Account/
Department/
Source currency

Enter a starting and ending number to define the range
of accounts, departments, or source currencies to export.

6) Click Export to proceed with the export process.
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Financial Reporter
There are very few differences between using the Adagio Financial Reporter with
single and multiple currency data sets.

However, when working with multi-currency data sets, you may wish to pay special
attention to these added features in the Financial Reporter:

• Special optional multiplier parameter in many Adagio functions
• Added multicurrency features in the drill-down function

Multiplier Parameter
Several Adagio functions include an optional multiplier parameter which multiplies
the result of the function by the value you specify. This parameter is especially useful
in representing source currencies in a home equivalent value.

The multiplier used can be a hard-coded value; a cell reference; or a function that
returns a value.

The functions which include this parameter are:

• ADAVERAGE
• ADCREDIT
• ADCRONLY
• ADDEBIT
• ADDRONLY
• ADGET
• ADMAX
• ADMIN

We’ll use the ADAVERAGE function to demonstrate how to make use of the
multiplier parameter.

Syntax
The multiplier parameter is added on to the end of the function, as such:

=ADAVERAGE(link.field,record range[,multiplier])

Financial Reporter
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Example
If gldata is a link to a General Ledger database that contains accounts 1000, 1100,
1200, and 1300, with the following balances:

1000 123.00

1100 99.80

1200 -256.57

1300 419.37

for a total balance of 385.60

the following function:

=ADAVERAGE(“gldata.bal”,"1000:1300",.78)

would result in a value of 75.19, which is the sum of the accounts (385.60) divided by
the number of accounts (4), and then multiplied by a hard-coded exchange rate.

You could specify an exchange rate in another cell in the report, to make it easier to
change and use for multiple calculations in the report. For example, if we inserted the
exchange rate 0.78 in cell B2, we would use the function in the same way but with a
cell reference for the multiplier parameter rather than a hard-coded value.

=ADAVERAGE(“gldata.bal”,"1000:1300",$B2)

If field is a text string or date, =ADAVERAGE returns the content of
field from the last record in record range. In this case, of course, the
multiplier parameter would not be useful.

Drill-down to Details
Whether you’re working with single or multiple currencies, the Financial Reporter
allows you to drill down to the General Ledger Posted Details while in cells that
contain any of the following functions:

• ADGET
• ADDEBIT
• ADCREDIT
• ADCRONLY
• ADDRONLY
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Drill-down Level 1
Drill down to the posted details from any cell containing one of the above-listed
functions simply by clicking the right mouse button on that cell. Select Details from
the pop-up menu to open the first drill-down level.

If you are working with a field that includes the optional multiplier parameter (such
as a source currency value you are converting to a home equivalent value by
multiplying it by an exchange rate), the above window will also display an
“Equivalent” column which shows you the original value and the multiplier value.
For information on using the multiplier parameter, see the Multiplier Parameter
section earlier in this chapter.

While in this window, you can modify the period field to view the details of other
periods. This will not change anything in the underlying Financial Report.
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Drill-down Level 2
In addition to this basic drill-down, you can go further. Specifically, double-clicking
on an Account/Department field in the drill-down grid will take you to the year’s
summary.

Drill-down Level 3
From that summary, double-clicking on a Fiscal Period in the grid will give you the
Posted Details for that period.
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In the above example, you can see multi-currency specific columns (Source Currency,
Source Amount, and Rate) for each transaction listed, in addition to the standard
detail columns for single and multicurrency data sets.

And, as before, you can view the details of other periods by changing the Period in
the drop-down field at the top of the window.

Clicking the Close button at any time will take you back to the Financial Reporter;
clicking Back will return you to the previous drill-down grid.
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Appendix B
Adagio Receivables

Once you have set up your currency codes and other multicurrency options in the
Adagio MultiCurrency module, There are a few steps involved in using
multicurrency data with Adagio Receivables, from setting up your Receivables to
work with multicurrency to processing transactions.

The following topics explain the process briefly, and the sections indicated will
provide complete information on each step.

Setting Up Your Receivables
To begin your multicurrency work in Receivables, you need to turn on the
multicurrency option in your Company Profile.

Transaction Processing
When entering and editing batches and transactions in Adagio Receivables, there are
some specific multicurrency fields of which you should be aware.

Revaluation
Your transactions need to be revalued periodically. This section will show you how
to revalue amounts.

Updating Recurring Charges
When you update your recurring charges, you must specify a currency for the
update. This causes Adagio Receivables to only update the recurring charges for
those customers who use the currency you indicate.
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Calculating Customer Aging
When calculating customer aging, you can put customers on hold based on their
aging. To do so, you must enter dollar amounts for each aging period. These dollar
amounts are entered in your company's home currency.

Reporting
This section explains the impact that multicurrency data has on the standard reports
in Adagio Receivables.



Setting Up Your Receivables

Editing the Company Profile
The Company Profile includes a multicurrency flag, which turns multicurrency on
for the database.

To activate multicurrency:

1) Select Company Profile from the Edit menu, or click the Profile button on the
Toolbar. The Company Profile screen appears with the Company Data tab in
front.

2) Turn the Use multicurrency checkbox on if you want this data set to be able to
read in, post, and process data from multiple currencies. When you turn this
option on, certain fields and functions specific to multi-currency data sets will
become available to you.
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Once you turn the multicurrency option on, you cannot turn it off
again. You may choose not to use the multicurrency functions in the
future, but you cannot simply turn it off at a future date.

3) This tab also specifies the Home currency, which is the default currency code
you’ve set up in Adagio MultiCurrency or Adagio Receivables’s Currency Codes
function.

4) In the Default Rate Type field, select your preferred default rate type for use in
Receivables. It should be the rate type you use most often. However, the default
rate type can be changed as needed when you are editing batches and so forth.

Rate types are set in the Adagio MultiCurrency module; for more information
rate types, see Chapter 4 of this manual.

5) Next, click on the Integration/Reports tab. The following screen appears.

In the Consolidate revaluations by field, you will need to indicate how you'd
like Adagio to consolidate your revaluation transactions. You can concolidate
according to the Revaluation Criteria you use; or by Control Account,
Customer, or Detail.
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6) Click OK to save the multicurrency settings in your Company Profile.

Once you have set these options in your Company Profile, you are ready to begin
working with Adagio Receivables’s multicurrency functions.

Additional Setup Options
Once you’ve turned the multicurrency flag on, you may want to modify the data in
the Customer, Account Set, and Distribution Code functions to reflect certain
multicurrency preferences.

Editing Account Sets
When the multicurrency option is activated, the Edit Control Account Set window
includes two additional multicurrency fields:

For each account set, you need to indicate the Currency that will be used for
customers who are assigned to this control account set. This will make transaction
entry faster and will prevent data entry errors.
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If you’ve selected a currency other than your home currency in the Currency field,
you will also need to specify the following:

Field Description

Rate type Specify the default rate type to be used for customer
transactions that use this account set. Your rate types
are set in Adagio MultiCurrency; see chapter 4 for more
information.

Unrealized exch.
gain/loss

Set the Ledger account that will be debited or credited
with unrealized gains or losses on multicurrency
transactions. This is a temporary “holding” account for
these gains or losses.

Since exchange rates fluctuate regularly, you may lose
or gain small amounts on the payment of an invoice;
this is one of the two accounts required to allow Ledger
to properly process those small gains or losses.

Realized exch.
gain/loss

As above, set the Ledger account that will be debited or
credited with realized gains or losses on multicurrency
transactions.

This is the final account that will be credited or debited
with gains and losses on exchange, once invoices have
been paid and Adagio Receivables posts the revaluation
data to Adagio Ledger.

Exchange rounding
error

Indicate the Ledger account that should be debited or
credited with the small rounding errors that occur when
dealing with exchange rates.

This is a temporary control account; rounding errors are
ultimately posted in the Ledger as realized gains or
losses on exchange (see above).
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Editing Customers
When you have set up Control Account Sets for the currencies you require, you can
then create new international customer files, assigning them the appropriate Control
Account Set for the currency they will use.

Once you do so, every time you create transactions for that customer, their
transactions will automatically be entered in the currency specified In the Control
Account Set.

You CANNOT edit an existing customer to reassign them to a
multicurrency Control Account. If you want to change an existing
customer to a multicurrency account set, you need to recreate that
customer from scratch.

You will also want to take note of the Tax group and Tax type options in the
Customer window, as you may need to assign your international customers to
different tax groups than your home currency customers. Please see your Adagio
Receivables manual for more information on these fields.
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Editing Distribution Codes
Once you begin using multiple currencies, you may also wish to create distribution
codes that distribute sales figures to the appropriate General Ledger accounts, such
as international currency sales accounts you may have set up in the GL.

See your Adagio Receivables manual for information on setting up distribution
codes.
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Working with Transactions
There are two aspects of transaction processing that are affected when you are
working with a multicurrency data set. These are:

• Entering and editing batches
• Running inquiries

This section will explain the multicurrency options that impact these functions.

Entering and Editing Batches
Batch entry is discussed fully in the Adagio Receivables manual, which can be
referred to for basic batch entry information. In this section, only those fields and
options that pertain to multicurrency will be explained.

Invoices
When adding or editing an invoice, when you select a customer in the first field of
the invoice window, some multicurrency information and options regarding that
customer will appear:
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On the left, the currency that is assigned to this customer (according to their account
set) is listed, along with the rate type, such as “SP” for “spot rate” in this example.

On the right, the Exchange rate field appears. This rate is taken from Adagio
Multicurrency’s exchange rate tables, and is chosen according to the rate type and the
date of the invoice you’re entering here.

If the rate type displayed to the left requires an exact match -- that is, there must be
an exchange rate in your rate tables for the specific transaction date -- but no exact
match can be found, you will be able to select a rate from the rates on file by clicking
on the Finder button.

You cannot change the currency on an invoice; customers will
always be invoiced in the currency that is used in the control
account set they’ve been assigned.

If you want a customer to be invoiced in a different currency, you
must re-enter that customer’s information and assign them to a
home or other source currency control account set.

Entering Payments for Invoices
Using the Payment button in the invoice entry window, you can also enter payments.

All payments entered via the Payments button will default to the same exchange
rate displayed on the invoice. If you are receiving a payment at a later date and
wish to specify an alternate date for the payment so that the exchange rate will be
selected based on payment, rather than invoice, date, then you must enter the
payment in a Cash Batch.

To enter a payment, click the Payment button from the invoice entry window.
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To enter a payment, complete these fields:

Field Description

Check number Enter the check number in this field.

Currency code Select the currency for the payment. By default, Adagio
Receivables assumes that your customers will be paying
you in the same currency they are invoiced in -- that is,
the currency used in the control account set to which the
customer has been assigned. However, unlike with
invoices, you can change the currency for payments by
clicking the Finder button here and choosing from the
currency list.

Payment Enter the payment amount, in the source currency.

Exchange rate This field can’t be edited, but will display the exchange
rate that was selected based on the rate type.

[Currency] Equivalent This field displays the amount of the Payment field after
it has been converted to the customer’s currency. If the
payment is the same currency as the invoice, then the
value in this field will match the value entered in the
Payment field. However, if you selected an alternate
Currency code for this payment, then this field will
convert the value of the payment into the customer’s
currency so that you can see whether it is equivalent to
the invoiced source currency amount or not.

Discount If this customer is eligible for a discount according to
the Terms field, the amount of the discount will be
entered in this field.

Account set Enter the Control Account Set for this payment in this
field. You can use the Finder to quickly look up all of
the account sets on file.

By default, the Account set finder will display the
account set assigned to each Customer record.
Normally, you will want to accept this default.
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Field Description

Acct/Dept If you leave the Account set field blank, you can
manually enter the G/L account and department to
which this payment will be applied in these fields. This
should be the G/L account for your bank.

If you have entered a value in the Account set field,
these fields will be filled in automatically, and will be
grayed out so that they cannot be edited. These fields
will display the G/L bank account and department
numbers as set up in the Control Account Set function.

Cash Batches
When adding or editing a check, when you select a customer in the first field of the
check window, some multicurrency information and options regarding that customer
will appear:

When you enter a Customer code in the first field, that customer’s currency
information is used by default. Or, if you do not enter a customer code and instead
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are entering a miscellaneous cash receipt, Adagio Receivables assumes you’re
entering home currency amounts and selects that as your currency instead.

For either a customer check or cash receipts, you can change the Currency code,
however. Simply click the Finder button to the right of the Currency code field and
select the currency in which the cash is being received.

Once you have indicated a currency or have accepted the default, the middle portion
of this window displays the following currency information:

Field Description

[Payment Currency]
Payment

Enter the payment amount, in the source currency.

[Payment Currency]
Rate

This field will display the exchange rate for the cash
receipt, based on the Check date you entered above.
This rate is based on your rate tables in Adagio
MultiCurrency.

If you need to select a different exchange rate, use the
Finder button to choose from a rate box; or manually
enter an alternate exchange rate as needed.

NOTE: If you manually enter an alternate rate, Receivables
will confirm that the rate you entered falls within your
acceptable “rate spread” as defined in Adagio MultiCurrency;
if not, it will let you know and ask you to confirm that you do
wish to use the rate you entered.

[Customer Currency]
Payment

This field displays the amount of the [Payment
Currency] Payment field above after it has been converted
to the customer’s currency. If the payment is the same
currency as the customer’s assigned currency, then the
value in this field will match the value entered in the
[Payment Currency] Payment field. However, if you
selected an alternate Currency code for this payment,
then this field will convert the value of the payment into
the customer’s currency so that you can see the
equivalent amount of the payment in the customer’s
own currency.

For a miscellaneous receipt, the conversion to home
currency will be shown.
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Field Description

Unapplied This field displays the amount of the payment that has
not yet been applied. The amount of cash applied will
be subtracted automatically from the payment amount.
See your Adagio Receivables manual for more
information on this field.

Description Enter a description of this payment here.

Payment details list This portion of the window displays a list of the
payment details. See your Adagio Receivables manual
for more information on adding payment details.

Adjustments
When adding or editing an adjustment, when you select a customer and a document
in the top portion of the adjustment window, some multicurrency information and
options regarding the selected transaction will appear:
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By default, the Exchange rate field will use the original document’s exchange rate;
however, if you need to change it, you can click on the Finder button and select a
different rate from the window that appears. Exchange rates are listed in the pop-up
window by rate type and date, allowing you to easily select a more appropriate rate
as needed.

You can also type in the exchange rate manually. As with other functions in Adagio
Receivables, if you manually enter an alternate rate, Receivables will confirm that
the rate you entered falls within your acceptable “rate spread” for the rate date as
defined in Adagio MultiCurrency; if not, it will let you know and ask you to confirm
that you do wish to use the rate you entered.

See your Adagio Receivables manual for information on entering the adjustment
itself.

Running Inquiries

Customer Inquiries
All of the data displayed in the customer inquiry mode is source currency data. This
includes the statistical and transaction data.

Company Aging and Batch Status Inquiries
The amounts displayed in the Company Aging and Batch Status inquiry functions
are all home currency amounts.
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Revaluing Accounts
Because currency rates fluctuate, your receivables accounts may need to be revalued
from time to time to reflect the true value of your outstanding receivables in your
home currency.

Journal Entries

Original Transaction
When you create a multicurrency invoice, the Ledger journal entries are very
straightforward. For example, if you are a US company with a customer who gets
invoiced in Canadian dollars, your initial invoice journal entry would be something
like this:

Source
amount

Exchange
rate

Home amount
equivalent

DR Cdn Receivable Control Acct 100.00 0.82500 82.50

CR Cdn Sales 100.00 0.82500 82.50

Revaluation Before Payment
Assuming that the customer does not pay the invoice immediately and you revalue
the outstanding amount of the invoice prior to payment, the home currency
equivalent amount of the invoice will change.

For instance, if the exchange rate changes to 0.84000 on the day you revalue your
accounts, the following journal entries would occur:

Home amount
equivalent

DR Cdn Receivable Control Acct 1.50

CR Unrealized gain on exchange 1.50
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This amount is calculated by subtracting the original exchange rate used for the
transaction (0.82500) from the current exchange rate at the time of revaluation
(0.84000), and multiplying it by the source amount of the invoice:

(0.84000 - 0.82500) x 100.00 = 1.50

Payment
When the payment is received, the value of the initial invoice is reassessed again
with current exchange rate data, and then the Ledger journal entries follow:

Source
amount

Exchange
rate

Home amount
equivalent

DR Cash 100.00 0.83000 83.00

CR Cdn Receivable
Control Acct 100.00 0.83000 83.00

DR Unrealized gain on exchange 1.50

CR Realized gain on exchange .50

CR Cdn Receivable
Control Acct 1.00

The bottom portion of the above journal entries demonstrates that the full amount of
the unrealized gain/loss on exchange is reversed, and then the actual, realized
amount of gain/loss is posted.

The realized amount of gain/loss is calculated by subtracting the original exchange
rate used for the transaction (0.82500) from the current exchange rate at the time of
payment (0.83000), and multiplying it by the source amount of the invoice:

(0.83000 - 0.82500) x 100.00 = 0.50

Gain/loss on exchange is ONLY realized at the time of posting for
cash payments. All other forms of gains and loss on exchange --
including adjustments, credit notes, and debit notes -- remain
unrealized until you run period end or print/clear statements.
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Setting Up Revaluations
To revalue source currency amounts, you simply need to set up a revaluation
template and then update the rate as needed.

To set up the revaluation template, follow these steps:

1) From the Maintenance menu, select Multicurrency Revaluation | Revaluation
List. The following window appears:

This window lists all of the revaluation templates you’ve set up.

2) To create a newtemplate, click New. The Edit window appears:
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Complete the fields in this window according to the following table:

Field Description

Revalue currency Select the currency that you wish to set up the
revaluation options for. You can use the Finder button
to select from a list of possible currencies.

Control account If you wish, you can narrow the revaluation of the
selected curerncy to a single control account, or a small
range of control accounts. To choose a single control
account, enter that control account code in both the
starting and ending range fields here; or to choose a
range of accounts, enter the starting account set in the
first field and the last account set in the range in the
second field.

By default, Adagio Receivables will revalue all control
accounts for this currency unless you specify otherwise.

Customer If you wish, you can narrow the revaluation of the
selected currency to one customer, or to a select range of
customers. To choose a single customer, enter that
customer code in both the starting and ending range
fields here; or to choose a range of customers, enter the
starting customer code in the first field and the last
customer code in the range in the second field.

By default, Adagio Receivables will revalue all
customers for this currency unless you specify
otherwise.

Revalue date Enter the date you wish to use for the revaluation. This
is the date that Adagio will use when it pulls the
exchange rate information from Adagio Multicurrency.

This date will be used the first time that you run the
revaluation after setting up this template; for future
uses, when you select the template and click the Update
Rate button, Adagio will instead use the program date
(the date you entered in the Open Data window when
you started Adagio Receivables).

Revaluing Accounts
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Field Description

Revalue rate This field will display the exchange rate for the date you
entered above. This rate is based on your rate tables in
Adagio MultiCurrency.

If you need to select a different exchange rate, use the
Finder button to choose from a rate box; or manually
enter an alternate exchange rate as needed.

NOTE: If you manually enter an alternate rate, Receivables
will confirm that the rate you entered falls within your
acceptable “rate spread” as defined in Adagio MultiCurrency;
if not, it will let you know and ask you to confirm that you do
wish to use the rate you entered.

Previous date This field is for your information only and cannot be
edited. It displays the date that this revaluation was last
run, if any.

Last rate This field is for your information only and cannot be
edited. It displays the exchange rate that was used the
last time this revaluation was last run, if applicable.

3) Click OK to save this revaluation template. It will be added to the template list.

Running a Revaluation
When you’ve set up a template for a particular currency, along with any criteria you
wish to specify, you can run the revaluation. This is usually done in three steps:

• Updating the Rate
• Reviewing the Revaluation Listing
• Posting the Revaluation
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These steps are all done from the Multicurrency Revaluation window. To open this
function, select Multicurrency Revaluation from the Maintenance menu. The
revaluation templates are listed on the left; to work with them, simply select a
template by clicking it once to highlight it, and then click the appropriate button to
the right.

The revaluation steps are described in detail below.

1. Updating the Rate
When you are ready to run a revaluation, generally you will want to use the most
current exchange rate data; in order to do so, you must tell Adagio to retrieve the
latest exchange rate from Adagio MultiCurrency.

To get the updated rate:

1) From the Multicurrency Revaluation window, select the currency template
whose rate you wish to update by clicking it once to highlight it. Then, click the
Update Rate button. You will be asked:
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2) Click Yes. This will retrieve the exchange rate for the program date you entered
in the Open Data window when you started Adagio Receivables.

If you prefer to use a different date for the revaluation, you do not need to run the
Update Rate function. Instead, open the currency template by double-clicking on it
in the list, and then enter the desired date and rate in the window that appears. Click
OK to save it, and that is the rate that will be used for the revaluation unless or until
you run Update Rate in the future.

2. Reviewing the Revaluation Listing
Before you post the revaluation and change your Ledger accounts, you will probably
want to review the impact that the revaluation will have on your unrealized and
realized gains/losses on exchange accounts. You can do this by printing a
revaluation listing.

1) From the Multicurrency Revaluation window, select the currency template(s)
you’d like to revalue.

You can select multiple templates to include on the listing by
holding down the Ctrl key while you click each one of the currency
templates you wish to include; or you can select a range of
templates by clicking the first one to select it, then holding down
the Shift key while you click the last one in the range.

2) Click the Listing button. You will be asked:

3) Click Yes. A listing report will be created and printed. This report includes:

• The currencies that will be revalued, with the rate used the last time you
revalued that currency, and the rate that will be used for this revaluation.

• The transactions that will be affected by the revaluation. For each transaction it
will list:

• The revaluation rate that will be used.
• The previous and the new amounts for the unrealized gain/loss on

exchange.
• The total realized gain/loss on exchange.
• The source amount for each transaction.
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• The new home currency equivalent amount for the transaction based on
the new revaluation rate.

4) If the information on the listing is correct and you wish to proceed with the
revaluation, the next step is to Post it.

If the information is not correct and you want to adjust the rate to use a different
date and exchange rate, or to limit or broaden the control account and customer
criteria, you can do so by editing the template and running the listing again.

3. Posting the Revaluation
When you’re satisfied with the information presented in the pre-revaluation listing
report, you can then post the revaluation. This will cause the changes indicated on
the listing report to be posted to your Ledger’s unrealized and realized gains/losses
on exchange accounts.

To post the revaluation:

1) From the Multicurrency Revaluation window, select the currency template(s)
you’d like to revalue.

You can select multiple templates to revalue by holding down the
Ctrl key while you click each one of the currency templates you
wish to include; or you can select a range of templates by clicking
the first one to select it, then holding down the Shift key while you
click the last one in the range.

2) Click the Post button. You will be asked to confirm this action:
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3) Click Yes to proceed. Adagio Receivables will process the transactions and then
tell you:

Click OK. You will be returned to the Multicurrency Revaluation window. From
there, you can revalue other currencies or simply exit the function.

When a revaluation has been posted, the Date and Rate columns in the Multicurrency
Revaluation window will be cleared out or set to zero, and will remain so until you
update the rate using the Update Rate button or until you edit that currency
template using the Edit button.

Revaluation Posting Journal
Once you have posted your revaluations, you can also print a Revaluation Posting
Journal by selecting Maintenance | Multicurrency Revaluation | Print Revaluation
Posting Journal. This posting journal contains the same data as the listing report,
along with a GL summary.

Deleting Revaluations
If you do not need to run a given revaluation regularly -- for example, if you set up a
revaluation to quickly revalue one customer’s accounts and don’t intend to use that
template again -- you can delete a revaluation. To do so, select the currency template
you wish to delete from the Multicurrency Revaluation window, then click Delete.
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Updating Recurring Charges
When working with the Update Recurring Charges function, multicurrency users
must specify the currency for the recurring charge being updated.

To run this function, select Update Recurring Charges from the Maintenance menu.
The following window appears with one multicurrency-specific field included:

You will note that to the right of the Update Recurring Charge field, there is a
currency option. In the currency field, you must specify the currency for the
recurring charge being updated. Adagio Receivables will only update this recurring
charge for customers who use the currency you specify here. (NOTE: A customer's
currency is determined by the Account set you've assigned them to.)
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Calculating Customer Aging
In the Calculate Customer Aging function on the Maintenance menu, you have the
ability to put customers on hold according to their aging. This is done in the Aging
amounts row of fields:

Multicurrency users should be aware that aging calculations are done according to
their home currency.

Calculating Customer Aging
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Reporting
This section explains the impact that multicurrency databases have on Adagio
Receivables reports.

Source vs. Home Currencies

Printing Equivalent Home Amounts
Several Adagio Receivables reports include the Print home equivalent amount
option.

When you turn this option on, all transactions listed on reports will be displayed in
their source currency amount and, if they include foreign currency transactions, their
home equivalent amount will also appear. For example, on the batch listing reports,
the total line for an invoice will be given twice for foreign currency transactions: the
first line will display the total of the source currency, and the second line will display
the total of the transaction in the home currency equivalent amount.

Reporting
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Choosing the Currency Data to Include
Several reports allow you to choose whether to print amounts in source or home
currency, or in both. For example, when you select Print/Consolidate G/L
Transactions from the Reports menu, you are given the following currency options:

In the Amounts printed in currency section, you have these choices:

Field Description

Source Select this to have the report display source currency
amounts only. The report will not include any home
currency equivalent amounts if this option is selected.

Home Select this to have the report display home currency
equivalent amounts only. The report will not include
any source currency amounts if this option is selected.

Source + home Choose this option if you want the report to include
your G/L transaction data in both the source and the
home currencies.

This option appears on the Print/Consolidate G/L Transactions report as well as
most of the Transaction and Analysis Reports.
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Batch Listings
The batch listing reports, found on the Reports | Batch Listings fly-out menu,
include the Print home equivalent amount option discussed above.

On the reports themselves, the currency and exchange rate information (rate type,
rate, rate date) are displayed for each transaction listed. In addition, the end of the
report provides totals for each currency for which transactions appear on the report,
along with a grand total in the home currency amount.

Customer Reports
Both the Customer List and Statements / Letters print functions on the Reports
menu are the same for multicurrency data as they are for single currency databases.
However, it is important to note that the amounts that are included on these reports
are source currency amounts.

Other Reports
All reports that provide general information and account totals will include home
currency amounts unless specified otherwise. This includes the reports on the
Reports | General Reports fly-out menu. See your Adagio Receivables manual for
specific information on working with these reports.
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Appendix C
Adagio Payables

In conjunction with the Adagio MultiCurrency module, Adagio Payables allows you
to work with multiple currencies through several special features, which are
discussed in the following chapters.

This appendix covers multicurrency-specific functions. You may want to refer to the
Adagio Payables manual for some basic information as needed.
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Multicurrency Overview
There are a few steps involved in using multicurrency data with Adagio Payables,
from setting up your Payables to work with multicurrency to processing transactions.

The following topics explain the process briefly, and the chapters indicated will
provide complete information on each step.

Setting Up Your Payables

Chapter 2: Activating Multicurrency
The first step is to set up your currency codes and other multicurrency options in the
Adagio MultiCurrency module. Next, you need to turn on the multicurrency option
in your Company Profile in Adagio Payables. This chapter explains the basics about
activating the multicurrency options.

Transaction Processing

Chapter 3: Working with Transactions
When entering and editing batches and transactions in Adagio Payables, there are
some specific multicurrency fields of which you should be aware.

Revaluation

Chapter 4: Revaluation
As mentioned for chapter 2, your transactions need to be revalued periodically. This
chapter will show you how to revalue amounts.

Miscellaneous

Chapter 5: Reporting
This chapter explains the impact that multicurrency data has on the standard reports
in Adagio Payables.

Multicurrency Overview
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Activating Multicurrency
There are two basic steps in activating multicurrency for use in a particular Adagio
Payables database:

1) Set up your currency information in the Adagio MultiCurrency module.

2) Turn the multicurrency option on in the Company Profile in Adagio Payables
and set some defaults for multicurrency processing.

The following sections explain each of these steps.

Adagio MultiCurrency
Most of your multicurrency setup will be done in the Adagio MultiCurrency module,
which allows you to set up currency codes, rate types, and other data.

Information on working with the MultiCurrency module can be found in the Adagio
MultiCurrency manual or help file.

When working with a multicurrency data set, Adagio Payables uses currency codes
set up in Adagio MultiCurrency’s File | Currency Codes function

Editing the Company Profile
The Company Profile includes a multicurrency flag, which turns multicurrency on
for the database.

To activate multicurrency:

Activating Multicurrency
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Company Data tab
1) Select Company Profile from the Edit menu, or click the Profile button on the

Toolbar. The Company Profile screen appears with the Company Data tab in
front.

2) Turn the Use multicurrency checkbox on if you want this data set to be able to
read in, post, and process data from multiple currencies. When you turn this
option on, certain fields and functions specific to multi-currency data sets will
become available to you.

Once you turn the multicurrency option on, you cannot turn it off
again. You may choose not to use the multicurrency functions in the
future, but you cannot simply turn it off at a future date.

3) This tab also specifies the Home currency, which is the default currency code
you’ve set up in Adagio MultiCurrency or Adagio Payables’s Currency Codes
function.

Activating Multicurrency
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4) In the Default Rate Type field, select your preferred default rate type for use in
Payables. It should be the rate type you use most often. However, the default
rate type can be changed as needed when you are editing batches and so forth.

Rate types are set in the Adagio MultiCurrency module; for more information
rate types, you should refer to the Adagio MultiCurrency manual or help file.

Integration tab
Next, you need to click the Integration tab in the Company Profile window, and set
some accounts for processing exchange rate data.

Activating Multicurrency

Adagio Payables Page C-131



Set the following fields:

Field Description

Clearing exchange
gain/loss

When checks are cleared through the bank, the
exchange rate at the time of clearing may be different
from the exchange rate that was used by Adagio
Payables in calculating the original transaction value.

Use this field to specify the default G/L account you
wish to write these exchange rate differences to.

NOTE: This is a default only; this field can be modified for
each bank you set up.

Unrealized exchange
gain/loss

When accounts are revalued, Adagio Payables must
have a G/L account to which to write the changes in
your outstanding payables. This is a temporary clearing
account, in essence, since once payments are made and
cleared through the bank, the amounts stored here will
become Realized gains or losses.

Realized exchange
gain/loss

When payments are made and cleared through the
bank, there may be a difference between the exchange
rate recorded for the initial transaction, and that used
for the payment. This account stores any realized gains
or losses from the fluctuating exchange rates.

Exchange rounding
error

Enter a G/L account here to record rounding errors in
exchange rate valuation and revaluation processes.

Consolidate
revaluations by

This field allows you to specify the level of detail that
sound be sent to the General Ledger transaction file
when revaluations are posted.

Your options are to set the detail according to the
Revaluation Criteria used in the Revaluation function;
or by the Control Account, Vendor, or the transacton
Detail.

Revaluation transactions that are retrieved into the G/L
will be grouped according to your selection here.

Once you have set these options in your Company Profile, you are ready to begin
working with Adagio Payables’s multicurrency functions.
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Program Options
Because some reports include both home and source currency data, the reports tend
to be wider. If you need to use some different settings for your multicurrency
printing needs, edit the fields in the MultiCurrency Report Printer/Orientation
Landscape section of the Options window.

To set your multicurrency printing options, select Program Options from the File
menu.

First, choose your Paper size. You can either choose to print multicurrency reports on
Legal paper, or on Letter paper on a printer that has been set up specfiically for such
purposes.

If you choose Legal, you can indicate whether Payables should use your Default
printer or a Specific printer, and which Paper tray should be used in either case.

If you choose Letter on a dedicated scaled printer then you will simply need to
indicate the printer from the drop-down list that appears.
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Additional Setup Options
Once you’ve turned the multicurrency flag on, you may want to modify the data in
the Vendor, Account Set, and Distribution Code functions to reflect certain
multicurrency preferences.

Editing Banks
Setting up your banks properly is very important in a multicurrency data set. Adagio
Payables relies on the currency information entered for the bank to determine what
currency is being used when payments are made.

When the multicurrency option is activated, the Bank tab of the Edit Bank window
includes several additional multicurrency fields:

If the “Allow check reconciliation” option is turned off in the
Company Profile, some of the above fields will not be displayed.
These fields are:
- Bank error acct/dept
- Clearing exch. gain/loss
- Reconciling Currency
- Reconciling rate type

Activating Multicurrency
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If you’ve selected a currency other than your home currency in the Currency field,
you will also need to specify the following:

If the “Allow check reconciliation” option is turned off in the
Company Profile, some of the above fields will not be displayed.
These fields are:
- Bank error acct/dept
- Clearing exch. gain/loss
- Reconciling Currency
- Reconciling rate type

All other Bank options are the same as those used for single currency data sets. See
your Adagio Payables manual for complete information.

Editing Account Sets
When the multicurrency option is activated, the Edit Control Account Set window
includes several additional multicurrency fields.

You must set up multicurrency banks for each currency you plan to
use in your control account sets prior to using this function, if you
use the “Include bank with control account set” option in the
Company Profile.

Activating Multicurrency
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The multicurrency fields are:

Field Description

Currency For each account set, you need to indicate the Currency
that will be used for vendors who are assigned to this
control account set. This will make transaction entry
faster and will prevent data entry errors.

Default rate type If you’ve selected a currency other than your home
currency in the Currency field, you will also need to
specify the default rate type to be used for vendor
transactions that use this account set. Your rate types
are set in Adagio MultiCurrency; see your Adagio
MultiCurrency manual for more information.

Unrealized exch.
gain/loss

Specify the G/L account and department to which the
temporary, unrealized gains or losses on revaluated
multicurrency transactions should be written.

Realized exch.
gain/loss

Specify the G/L account and department to which final,
realized gains or losses on revaluated multicurrency
transactions should be written.

Exchange rounding
error

Indicate the G/L account and department that should
be used to record any rounding errors that occur during
conversion of source currencies to your home currency
for your Payables transactions.

Editing Distribution Codes
Once you begin using multiple currencies, you may also wish to create distribution
codes that distribute sales figures to the appropriate General Ledger accounts, such
as international currency sales accounts you may have set up in the GL.

See your Adagio Payables manual for information on setting up distribution codes.
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Editing Vendors

Vendor Information tab
When you have set up Banks and Control Account Sets for the currencies you
require, you can then create new international vendor files, assigning them to the
appropriate Control Account Set for the currency they will use.

Once you do so, every time you create transactions for that vendor, their transactions
will automatically be entered in the currency specified in the Control Account Set.

You CANNOT edit an existing vendor to reassign them to a
multicurrency Control Account. If you want to change an existing
vendor to a multicurrency account set, you need to recreate that
vendor from scratch.

You will also want to take note of the Tax group option in the Vendor Information
window, as you may need to assign your international customers to different tax
groups than your home currency customers. Please see your Adagio Payables
manual for more information on these fields.
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Working with Transactions
There are three aspects of transaction processing that are affected when you are
working with a multicurrency data set. These are:

• Entering and editing invoices and adjustments
• Editing vendors
• Processing payments
• Reconciling checks
• Running inquiries

In addition, check reconciliation for checks drawn on non-home currency banks
needs to be understood fully.

This chapter will explain the multicurrency options that impact these functions.

Working with Transactions
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Entering and Editing Batches
Batch entry is discussed fully in the Adagio Payables manual, which can be referred
to for basic batch entry information. This section will discuss how multicurrency data
affects batch entry.

Invoices and Adjustments
When adding or editing an invoice or adjustment, the currency of the transaction is
set according to the vendor you choose for the document. Each vendor is assigned to
a particular account set, and the vendor’s transactions are all carried out in that
account set’s currency. Thus, any invoice or adjustment you enter for that vendor
will be dependent on the account set you have assigned to them.

When you select the vendor for the transaction in the Vendor code field, their
currency will appear in the middle portion of the window, to the right.

In addition, an Exch. Rate field appears. This exchange rate is taken from Adagio
Multicurrency’s exchange rate tables, and is chosen according to the default rate type
set in the vendor’s account set.
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If you need to change the exchange rate that has been chosen, click the Finder button
to the right of the Exch. Rate field and select an alternate rate from the table that
appears. Or, manually type in the exchange rate you wish to use; Adagio will
confirm that it falls within acceptable parameters (as set in Adagio MultiCurrency) to
avoid clerical error.

You cannot change the currency on an invoice or adjustment; vendor
invoices will always be entered in the currency that is used in the
control account set they’ve been assigned.

If you want to enter a vendor invoice or adjustment in a different
currency, you must re-enter that vendor’s information and assign
them to a home or other source currency control account set.

Editing Vendors

Statistics - YTD tab
The Statistics - YTD tab of the Edit | Vendors function includes a new fields for
multicurrency datasets.
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The following field displays for multicurrency databases only:

Field Description

HEQ Outst. balance This field displays the vendor’s outstanding balance in the
home currency equivalent dollar amount, for non-home
currency vendors. (Vendors who bill in your home
currency will also display this field, but it will always be
equivalent to the Outstanding balance field.)

Transactions tab

Viewing Applied Transactions
During viewing or editing of a vendor file, the Transactions tab of the Edit |
Vendors function includes an Applied button which allows you to drill-down to
details of any current or historical transaction listed for a particular vendor.

When you do this in a multicurrency data set, this window includes some extra
multicurrency fields:
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The following multicurrency fields are displayed:

Field Description

Last revalued Lists the date on which this transaction was revalued
last, via the Multicurrency Revaluation function
discussed in Chapter 4 of this addendum.

Original rate Indicates the exchange rate that was originally recorded
for the transaction when it was first posted.

Current rate Indicates the exchange rate that is currently being used
for this transaction; it may be different from the
Original rate if the transaction has been revalued at any
point.

Home equivalent Indicates the current value of the transaction in your
home currency, based on the source currency amount
multiplied or divided by the current exchange rate.

Processing Payments

Payment Control
This function works just the same for multicurrency data sets as it does for single
currency data sets. However, please note that all amounts that are displayed in this
function are shown in the vendor’s currency.

See your Adagio Payables manual for general information on working with the
Payments | Payment Control function.

Printing Checks & Advices
Using the Print/Post Checks and Advices function on the Payments menu, you can
process payments for non-home currency bank accounts, just as you would for any
home currency account. (See your Adagio Payables manual for complete
information.)

Multicurrency data is included, however, in the Edit Payment window.
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When you select Print/Post Checks & Advices from the Payments menu, and you
choose a bank and generate the payments in the Payment tab, you can then view and
edit payment information for each payment listed.

The Edit Payment window will display both the Original amount and the Current
amount of the payment.

Field Description

Original amount Displays the original amount of the invoice, based on
the exchange rate used at the time of the original
transaction.

Current amount Displays the current amount of the transaction, with
any applicable debit or credit notes, adjustments, or
partial payments included.

Although these fields cannot be changed, they do provide information about the
value of the invoice as it originated, and now.
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These amounts are always displayed in the vendor’s currency. The actual amount
of the check that is printed will depend on the selected bank’s currency.

Manual Checks
The Manual Checks function includes currency and exchange rate information, and
allows you to edit exchange rates as needed.

As shown in the screen image below, two pieces of currency information are
available: bank currency and vendor currency.

Bank Currency
The currency for the bank you’ve chosen for this manual check batch will appear in
two fields:

• In the mid-section of the window, by the Check rate field.
• In the lower, right corner of the screen, in the Check amount field. This

indicates the dollar amount that the check will be written for, in the bank’s
currency.

If the bank account you’ve chosen is in your home currency, the Check rate exchange
rate will always be 1.00000000 and cannot be changed.
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If the bank account is in a foreign currency, the exchange rate will be taken from
Adagio MultiCurrency’s rate tables according to the rate type you’ve selected for this
bank, and the date of the check that is being created. However, this is a default only;
you can use the Finder button to the right to call up the exchange rate table and select
a different rate. Or, you can manually enter the exchange rate you wish to use, as
long as it falls within the acceptable range as set in Adagio MultiCurrency.

Vendor Currency
When you select a vendor on a manual check screen, the vendor’s currency also
appears in two places:

• Beside the Vendor rate field in the middle portion of the window.
• On the Total payable line in the lower, right portion of the screen. This

indicates the amount payable from the vendor’s invoice, in the vendor’s
currency.

If the vendor’s currency matches the home currency, the exchange rate will always be
1.0000000.

If both are the same source currency, the vendor exchange rate will match the check
exchange rate.

If the vendor’s currency is different from the home and bank currency, then the
exchange rate will instead taken from Adagio MultiCurrency’s rate tables according
to the rate type you’ve selected for this vendor’s control account set, and the date of
the check that is being created. However, this is a default only; you can use the
Finder button to the right to call up the exchange rate table and select a different rate.
Or, you can manually enter the exchange rate you wish to use, as long as it falls
within the acceptable range as set in Adagio MultiCurrency.

Printing the Manual Checks
When you have verified your exchange rate information for your manual checks, you
can print them as you normally would. See your Adagio Payables manual for
complete information.
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Reconciling Checks
The check reconciliation function in a multicurrency dataset works the same as it
does for single currency datasets. (See your Adagio Payables manual for complete
instructions.)

However, you will note that multicurrency datasets include the bank’s currency
information on the Reconcile Check window, as below:

Next to the Issued amount field, the currency is displayed.

If you need to edit the Cleared amount, you must specify the cleared amount in that
same currency -- as it would appear on your bank statement.

• If the bank is set up with the same currency for both the Check currency code
and the Reconciling Currency, then you will be able to alter the cleared
amount by selected the Cleared with error radio button.

• If the bank’s reconciling currency does NOT match its check currency, then
you will instead need to select the Cleared with difference option.

The Ledger account that is debited or credited with any difference between the
written check and the cleared amount is set in the Edit Banks function.

Working with Transactions

Page C-146 Adagio MultiCurrency



Running Inquiries

Vendor Inquiries
All of the data displayed in the vendor inquiry mode is source currency data. This
includes the statistical and transaction data.

Company Aging and Batch Status Inquiries
The amounts displayed in the Company Aging and Batch Status inquiry functions
are all home currency amounts.
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Revaluing Accounts
Because currency rates fluctuate, your Payables accounts may need to be revalued
from time to time to reflect the true value of your outstanding Payables in your home
currency.

Journal Entries

Original Transaction
When you create a multicurrency invoice, the Ledger journal entries are very
straightforward. For example, if you are a US company with a vendor whose invoice
was in Canadian dollars, your initial invoice journal entry would be something like
this:

Source
amount

Exchange
rate

Home amount
equivalent

DR Inventory 100.00 0.82500 82.50

CR Cdn Payables
Control Acct 100.00 0.82500 82.50

Revaluation Before Payment
Assuming that you do not pay the invoice immediately and you revalue the
outstanding amount of the invoice prior to payment, the home currency equivalent
amount of the invoice will change.

For instance, if the exchange rate changes to 0.84000 on the day you revalue your
accounts, the following journal entries would occur:

Home amount
equivalent

DR Unrealized loss on exchange 1.50

CR Cdn Payables Control Acct 1.50
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This amount is calculated by subtracting the original exchange rate used for the
transaction (0.82500) from the current exchange rate at the time of revaluation
(0.84000), and multiplying it by the source amount of the invoice:

(0.84000 - 0.82500) x 100.00 = 1.50

Payment
When the payment is made, the value of the initial invoice is reassessed again with
current exchange rate data, and then the Ledger journal entries follow:

Source
amount

Exchange
rate

Home amount
equivalent

DR Cdn Payables Control Acct 100.00 0.83000 83.00

CR Cash 100.00 0.83000 83.00

DR Cdn Payables Control Acct 1.00

DR Realized loss on exchange .50

CR Unrealized loss on exch. 1.50

The bottom portion of the above journal entries demonstrates that the full amount of
the unrealized gain/loss on exchange is reversed, and then the actual, realized
amount of gain/loss is posted.

The realized amount of gain/loss is calculated by subtracting the original exchange
rate used for the transaction (0.82500) from the current exchange rate at the time of
payment (0.83000), and multiplying it by the source amount of the invoice:

(0.83000 - 0.82500) x 100.00 = 0.50

Gain/loss on exchange is ONLY realized at the time of posting for
cash payments. All other forms of gains and loss on exchange --
including adjustments, credit notes, and debit notes -- remain
unrealized until you run period end.
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Setting Up Revaluations
To revalue source currency amounts, you simply need to set up a revaluation
template and then update the rate as needed.

To set up the revaluation template, follow these steps:

1) From the Maintenance menu, select Multicurrency Revaluation | Revaluation
List. The following window appears:

This window lists all of the revaluation templates you’ve set up.
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2) To create a new template, click New. The Edit window appears:

Complete the fields in this window according to the following table:

Field Description

Revalue currency Select the currency that you wish to set up the
revaluation options for. You can use the Finder button
to select from a list of possible currencies.

Control account If you wish, you can narrow the revaluation of the
selected curerncy to a single control account, or a small
range of control accounts. To choose a single control
account, enter that control account code in both the
starting and ending range fields here; or to choose a
range of accounts, enter the starting account set in the
first field and the last account set in the range in the
second field.

By default, Adagio Payables will revalue all control
accounts for this currency unless you specify otherwise.
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Field Description

Vendor If you wish, you can narrow the revaluation of the
selected currency to one vendor, or to a select range of
vendors. To choose a single vendor, enter that vendor
code in both the starting and ending range fields here;
or to choose a range of vendors, enter the starting
vendor code in the first field and the last vendor code in
the range in the second field.

By default, Adagio Payables will revalue all vendors for
this currency unless you specify otherwise.

Transaction date Enter the date you wish to use for the revaluation. All
Ledger journal entries for revaluation will be assigned
this date. This is also the date that Adagio will use when
it pulls the exchange rate information from Adagio
Multicurrency.

This date will be used the first time that you run the
revaluation after setting up this template; for future
uses, when you select the template and click the Update
Rate button, Adagio will instead use the program date
(the date you entered in the Open Data window when
you started Adagio Payables).

Revalue rate This field will display the exchange rate for the date you
entered above. This rate is based on your rate tables in
Adagio MultiCurrency.

If you need to select a different exchange rate, use the
Finder button to choose from a rate box; or manually
enter an alternate exchange rate as needed.

NOTE: If you manually enter an alternate rate, Payables will
confirm that the rate you entered falls within your acceptable
“rate spread” as defined in Adagio MultiCurrency; if not, it
will let you know and ask you to confirm that you do wish to
use the rate you entered.

Previous date This field is for your information only and cannot be
edited. It displays the date that this revaluation was last
run, if any.
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Field Description

Last rate This field is for your information only and cannot be
edited. It displays the exchange rate that was used the
last time this revaluation was last run, if applicable.

3) Click OK to save this revaluation template. It will be added to the template list.

Running a Revaluation
When you’ve set up a template for a particular currency, along with any criteria you
wish to specify, you can run the revaluation. This is usually done in three steps:

• Updating the Rate
• Reviewing the Revaluation Listing
• Posting the Revaluation

These steps are all done from the Multicurrency Revaluation window. To open this
function, select Multicurrency Revaluation from the Maintenance menu. The
revaluation templates are listed on the left; to work with them, simply select a
template by clicking it once to highlight it, and then click the appropriate button to
the right.

The revaluation steps are described in detail below.
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1. Updating the Rate
When you are ready to run a revaluation, generally you will want to use the most
current exchange rate data; in order to do so, you must tell Adagio to retrieve the
latest exchange rate from Adagio MultiCurrency.

To get the updated rate:

1) From the Multicurrency Revaluation window, select the currency template
whose rate you wish to update by clicking it once to highlight it. Then, click the
Update Rate button. You will be asked:

2) Click Yes. This will retrieve the exchange rate for the program date you entered
in the Open Data window when you started Adagio Payables.

If you prefer to use a different date for the revaluation, you do not need to run the
Update Rate function. Instead, open the currency template by double-clicking on it
in the list, and then enter the desired date and rate in the window that appears. Click
OK to save it, and that is the rate that will be used for the revaluation unless or until
you run Update Rate in the future.

2. Reviewing the Revaluation Listing
Before you post the revaluation and change your Ledger accounts, you will probably
want to review the impact that the revaluation will have on your unrealized and
realized gains/losses on exchange accounts. You can do this by printing a
revaluation listing.

1) From the Multicurrency Revaluation window, select the currency template(s)
you’d like to revalue.

You can select multiple templates to include on the listing by
holding down the Ctrl key while you click each one of the currency
templates you wish to include; or you can select a range of
templates by clicking the first one to select it, then holding down
the Shift key while you click the last one in the range.
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2) Click the Listing button. You will be asked:

3) Click Yes. A report dialog will appear, giving you the options for the listing:

Your options include:

Field Description

Report format Choose to print the revaluation transactions in Detail,
or to summarize them by vendor or control account. The
summary reports will group the revaluation
transactions according to either the total for each
vendor, or for each control account.

Print G/L dist.
summary

If you want a summary of the Ledger distributions to be
included on the bottom of the report, turn this option
on.
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4) When you click Print, a listing report will be created and printed. This report
includes:

• The currencies that will be revalued, with the rate used the last time you
revalued that currency, and the rate that will be used for this revaluation.

• The transactions that will be affected by the revaluation. For each transaction it
will list:

• The revaluation rate that will be used.
• The previous and the new amounts for the unrealized gain/loss on

exchange.
• The total realized gain/loss on exchange.
• The source amount for each transaction.
• The new home currency equivalent amount for the transaction based on

the new revaluation rate.

5) If the information on the listing is correct and you wish to proceed with the
revaluation, the next step is to Post it.

If the information is not correct and you want to adjust the rate to use a different
date and exchange rate, or to limit or broaden the control account and customer
criteria, you can do so by editing the template and running the listing again.

3. Posting the Revaluation
When you’re satisfied with the information presented in the pre-revaluation listing
report, you can then post the revaluation. This will cause the changes indicated on
the listing report to be posted to your Ledger’s unrealized and realized gains/losses
on exchange accounts.

To post the revaluation:

1) From the Multicurrency Revaluation window, select the currency template(s)
you’d like to revalue.

You can select multiple templates to revalue by holding down the
Ctrl key while you click each one of the currency templates you
wish to include; or you can select a range of templates by clicking
the first one to select it, then holding down the Shift key while you
click the last one in the range.
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2) Click the Post button. You will be asked to confirm this action:

3) Click Yes to proceed. Adagio Payables will process the transactions and then tell
you:

Click OK. You will be returned to the Multicurrency Revaluation window. From
there, you can revalue other currencies or simply exit the function.

When a revaluation has been posted, the Date and Rate columns in the Multicurrency
Revaluation window will be cleared out or set to zero, and will remain so until you
update the rate using the Update Rate button or until you edit that currency
template using the Edit button.
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Revaluation Posting Journal
Once you have posted your revaluations, you can also print a Revaluation Posting
Journal by selecting Maintenance | Multicurrency Revaluation | Print Revaluation
Posting Journal.

This report gives you several options:

Field Description

Report format Choose to print the revaluation transactions in Detail,
or to summarize them by vendor or control account. The
summary reports will group the revaluation
transactions according to either the total for each
vendor, or for each control account.

Page break on change
of post. seq.

Inserts a page break whenever there is a change of
posting sequence number.

Paging by posting
sequence

If you have Page break on change of post. seq. selected,
this allows you to reset the page number to 1 whenever
a new posting sequence begins.
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Field Description

Print G/L dist.
summary

If you want a summary of the Ledger distributions to be
included on the bottom of the report, turn this option
on.

Deleting Revaluations
If you do not need to run a given revaluation regularly -- for example, if you set up a
revaluation to quickly revalue one vendor’s accounts and don’t intend to use that
template again -- you can delete a revaluation. To do so, select the currency template
you wish to delete from the Multicurrency Revaluation window, then click Delete.
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Reporting
This chapter explains the impact that multicurrency databases have on Adagio
Payables reports.

Source vs. Home Currencies

Printing Equivalent Home Amounts
Several Adagio Payables reports include the Print home equivalent amounts option.

When you turn this option on, all transactions listed on reports will be displayed in
their source currency amount and, if they include foreign currency transactions, their
home equivalent amount will also appear. For example, on the batch listing reports,
the total line for an invoice will be given twice for foreign currency transactions: the
first line will display the total of the source currency, and the second line will display
the total of the transaction in the home currency equivalent amount.
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Choosing the Currency Data to Include
Several reports allow you to choose whether to print amounts in source or home
currency, or in both. For example, when you select Print/Consolidate G/L
Transactions from the Reports menu, you are given the following currency options:

In the Amounts printed in currency section, you have these choices:

Field Description

Source Select this to have the report display source currency
amounts only. The report will not include any home
currency equivalent amounts if this option is selected.

Home Select this to have the report display home currency
equivalent amounts only. The report will not include
any source currency amounts if this option is selected.

Source + home Choose this option if you want the report to include
your G/L transaction data in both the source and the
home currencies.

This option appears on the Print/Consolidate G/L Transactions report as well as
most of the Transaction and Analysis Reports.
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Batch Listings
The batch listing reports, found on the Reports | Batch Listings fly-out menu,
include the Print home equivalent amount option discussed above.

On the reports themselves, the currency and exchange rate information (rate type,
rate, rate date) are displayed for each transaction listed. In addition, the end of the
report provides totals for each currency for which transactions appear on the report,
along with a grand total in the home currency amount.

Vendor List
The Vendor List print function on the Reports menu is the same for multicurrency
data as it is for single currency databases. However, it is important to note that the
amounts that are included on this report are source currency amounts.

Other Reports
All reports that provide general information and account totals will include home
currency amounts unless specified otherwise. This includes the reports on the
Reports | General Reports fly-out menu. See your Adagio Payables manual for
specific information on working with these reports.
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Appendix D
Adagio OrderEntry

Adagio OrderEntry allows you to enter invoices and payments in multiple currencies
through a few special features, which are discussed in the following sections.

This appendix covers multicurrency-specific functions for OrderEntry. You may
want to refer to the Adagio OrderEntry manual for some basic information as
needed.
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Multicurrency Overview
There are a few steps involved in using multicurrency data with Adagio OrderEntry,
from setting up your OrderEntry to work with multicurrency to processing
transactions.

The following topics explain the process briefly, and the chapters indicated will
provide complete information on each step.

Setting Up Your OrderEntry

Activating Multicurrency
The first step is to set up your currency codes and other multicurrency options in the
Adagio MultiCurrency module. You will also need to ensure that your Adagio
Receivables data is 8.0 or higher and that you have turned the multicurrency flag on
in the Receivables Company Profile.

Next, you need to turn on the multicurrency option in your Company Profile in
Adagio OrderEntry, and set up your price lists, tax groups, and miscellaneous
charges. This section explains the basics about activating the multicurrency options.

Orders and Payments

Working with Transactions
Orders: Adagio OrderEntry uses exchange rates for non-home currency customers
based on the customer’s control account set.

Payments: When entering and editing payments in Adagio OrderEntry, there are
some specific multicurrency fields of which you should be aware.

Miscellaneous

Reporting
This section explains the impact that multicurrency data has on the standard reports
in Adagio OrderEntry.
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Activating Multicurrency
There are two basic steps in activating multicurrency for use in a particular Adagio
OrderEntry database:

1) Ensure that you have Adagio MultiCurrency 8.0B or higher installed, and set up
your currency information in the Adagio MultiCurrency module.

2) Ensure that your Adagio Receivables data is 8.0A or higher and that you have
turned the multicurrency flag on in the Receivables Company Profile. (See your
Adagio Multicurrency manual for more information.)

3) Turn the multicurrency option on in the Company Profile in Adagio OrderEntry
and set some defaults for multicurrency processing.

4) Set up your alternate price lists, tax groups, and miscellaneous charges for
multicurrency processing.

The following sections explain each of these steps.

Adagio MultiCurrency
Most of your multicurrency setup will be done in the Adagio MultiCurrency module,
which allows you to set up currency codes, rate types, and other data.

Adagio OrderEntry will use the currency codes you’ve set up in your Receivables
data set. Currency code editing is documented in the Adagio Fundamentals manual.

Adagio Receivables
Ensure that your Adagio Receivables data is 8.0 or higher and that you have turned
the multicurrency flag on in the Receivables Company Profile.
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Editing the Company Profile
The Company Profile includes a multicurrency flag, which turns multicurrency on
for the database.

Users of other Adagio modules can only turn multicurrency on under these
circumstances:

• Multicurrency Receivables data must be present.
• If you have inventory data present, it must be multicurrency data. In this case,

you must turn on the multicurrency flag in the Inventory module, not in
Adagio OrderEntry.

To activate multicurrency:

1) Select Company Profile from the Edit menu, or click the Profile button on the
Toolbar. The Company Profile screen appears with the Company Data tab in
front.

2) Turn the Use multicurrency checkbox on if you want this data set to be able to
read in, post, and process data from multiple currencies. When you turn this
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option on, certain fields and functions specific to multi-currency data sets will
become available to you.

Once you turn the multicurrency option on, you cannot turn it off
again. You may choose not to use the multicurrency functions in the
future, but you cannot simply turn it off at a future date.

3) This tab also specifies the Home currency, which is the default currency code
you’ve set up in your Adagio Receivables data.

4) In the Default Rate Type field, select your preferred default rate type for use in
OrderEntry. It should be the rate type you use most often. However, the default
rate type can be changed as needed when you are editing batches and so forth.

Rate types are set in the Adagio MultiCurrency module; for more information
rate types, you should refer to the Adagio MultiCurrency manual or help file.

5) Click OK to save the multicurrency settings in your Company Profile.

Once you have set these options in your Company Profile, you are ready to begin
working with Adagio OrderEntry’s multicurrency functions.

Additional Setup Options
Once you’ve turned the multicurrency flag on, you may want to create or update the
data in your alternate price lists, as well as your tax groups and miscellaneous items.

Creating Alternate Price Lists
This function can only be used if Inventory Control data is not
present. If IC data is presenting, OrderEntry will use alternate price
list data from Adagio Inventory.

The alternate price list function may be especially useful to multicurrency users as it
allows you to quickly create a whole new set of alternate items for a specific
non-home currency using a specified exchange rate.

The process for creating alternate price lists with multicurrency OrderEntry data is
very similar to the standard procedure described in the Adagio OrderEntry manual.
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However, when multicurrency data is present, you have a couple of extra options. To
view these options, select Create Alternate Price Lists from Price Lists | Alternate
Price Lists on the menu bar.

When you want to create a set of alternate items that should be used for non-home
currency customers, you must select a Currency code for those items, to indicate
which of the currencies these alternate items will be used for.

Once you have chosen all of your other selection criteria, you must then move to the
bottom of the window. In the section Create the selected fields using, click the
drop-down arrow on the first field and choose Exchange rate.

If you have not chosen a currency other than your home currency in the Currency
code field above, you will not be able to modify the Exchange rate field. If the
Exchange rate field is grayed out, please go back to the Currency code field and
ensure that you have selected an appropriate source currency.

When a source currency is properly selected and you have chosen to create the
alternate price list based on Exchange rate, another field will appear to the right,
which allows you to select the exchange rate you’d like to use. You can click the
Finder button to view a list of exchange rates on file (as entered in Adagio
MultiCurrency), and choose from one of those rates. Or, you can manually type in
the desired exchange rate.

When you’re finished setting these fields, click Create. Adagio will create your
alternate price list items according to your criteria. Then, when you enter the
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Alternate Price List Items function, you will see the new items listed along with their
currency.

Editing Tax Groups
Tax group set-up is also affected by multicurrency data.

When you have multiple currencies, you must assign a currency to each tax group
you create. Normally you would use home currency, but if you have customers in
different countries and must remit taxes to jurisdictions in those countries, you may
need to set up tax groups accordingly.

A tax group is associated with every order, so there must be a tax group for every
currency code for which orders will be created.

Adagio OrderEntry requires that you enter a jurisdiction for a tax
group.

Tax groups are set up in exactly the same way that the Adagio OrderEntry describes,
except that there is one additional field: Currency.

Simply indicate the currency that should be used for this tax group, making sure to
select an appropriate GL account for those taxes as well.

Copying Tax Groups
Tax Groups can also be copied to help you speed up the tax group creation process. If
you want to copy an existing tax group and assign a new source currency to it,
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simply select it in the Tax Groups window, then click Copy. You will be prompted
for a new tax group name.

Enter the new tax group name, and then you will be prompted for the source
currency that should be used for this new tax group.

Enter the desired source currency and click OK Your new Tax Group will be created
and you can modify it as needed.

Creating Miscellaneous Charges
Miscellaneous charges are used for adding special charges onto invoices, such as
shipping or other charges that might not be handled by a standard OrderEntry or
Inventory Control item.

Because you can assign miscellaneous charges to any of your multicurrency
customers, you also need to specify the currency that is used for a miscellaneous
charge.

To create a miscellaneous charge, follow the procedure described in your Adagio
OrderEntry manual, and simply specify the Currency code for that miscellaneous
charge.

Miscellaneous charges for a foreign currency MUST have a price list
code.

Special Prices
The Edit | Special Prices function also includes a Currency code field; however, this
field is not editable and is displayed for your information only.

Once you select a customer for the special prices, that customer’s currency code will
be displayed on this window, to let you know which currency is applicable in this
case.
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Working with Transactions
There are two aspects of transaction processing that are affected when you are
working with a multicurrency data set:

• how Adagio OrderEntry determines the exchange rate for an order; and
• how to making payments on an order/invoice.

This chapter will explain the multicurrency options that impact these functions.

Exchange Rates on Orders
Adagio OrderEntry gives you the opportunity to set the exchange rate for an order,
in the case of non-home currency customers.

Default Rate
By default, Adagio OrderEntry looks at the customer file, determines their control
account set, and then refers to the control account set for appropriate exchange rate
information for the default rate type and matching.

In Adagio Receivables, the control account set indicates the currency that should be
used, and it also indicates the rate type. Rate types enable Adagio to choose the
closest and most appropriate exchange rate for a transaction based on the exchange
rate data found in Adagio MultiCurrency.

When you create an order in Adagio OrderEntry, all of this information is compiled
to select the most appropriate exchange rate for this customer’s order, based on the
order date and the rate type. It then automatically takes the exchange rate from
Adagio MultiCurrency and applies it to the order.
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Changing the Rate
If you wish to change the default exchange rate that Adagio OrderEntry has entered
for an order, you can do so by going to the Header tab for the order.

Simply go to the Rate field and use the Finder to select a rate type and rate from the
list that appears.

To view all rates for a certain rate type, click the + (plus) sign to the left of the rate
type code and then select a rate from the list that appears by double-clicking on it.
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Note that the currently selected rate is indicated by a small < sign to the right of the
rate.

You can also change the exchange rate via the Totals tab. See the Invoice rate field
on that tab, and follow the above instructions for selecting an alternate rate.

Making Payments
Using the Payment button in the order window, you can also enter payments to
invoices, specifying the currency in which the payment was received.

To enter a payment, click the Payment button from the order entry window.

To enter a payment, complete these fields:

Field Description

Payment method Payment methods are set up in Adagio Receivables, and
allow you to select the method by which the customer is
making the payment, such as VISA if you have entered
a payment method for customers using a Visa credit
card.

For multicurrency datasets, payment methods will often
specify the currency and the method (such as CVSA to
indicate Canadian Visa).

Select the appropriate payment method using the
Finder button.
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Field Description

Check number Enter the check or reference number in this field.

IMPORTANT NOTE: This field cannot be left blank if the
payment is to be saved. If you leave the field blank, the
payment information will be discarded.

Currency Select the currency for the payment. By default, Adagio
OrderEntry assumes that your customers will be paying
you in the same currency they are invoiced in -- that is,
the currency used in the control account set to which the
customer has been assigned. However, unlike with
orders and invoices, you can change the currency for
payments by clicking the Finder button here and
choosing from the currency list.

Payment Enter the payment amount, in the source currency.

If you have selected a Currency other than the
customer’s default currency, an additional field will
appear to the right of the Payment field, allowing you to
select an exchange rate for conversion of the payment
from the specified currency to the home currency.

If the payment is made in the home currency, the
exchange rate field will still appear, but it will not be
editable and will show an exchange rate of 1.0000000.

If you have gone ahead with the customer’s default
currency, this exchange rate field will still appear, but
will be grayed out. It will indicate the same exchange
rate used on the order -- a rate that is based on your
Adagio MultiCurrency tables and the customer’s
profile.
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Field Description

[Currency] Equivalent NOTE: This field will only appear if the Currency you
selected does not match the customer’s default currency.

This field displays the amount of the Payment field after
it has been converted to the customer’s currency. If you
selected an alternate Currency code for this payment,
then this field will convert the value of the payment into
the customer’s currency so that you can see whether it is
equivalent to the invoiced source currency amount or
not.

Discount If this customer is eligible for a discount according to
the Terms field, the amount of the discount will be
entered in this field.

Account set Enter the Control Account Set for this payment in this
field. You can use the Finder to quickly look up all of
the account sets on file.

By default, the Account set finder will display the
account set assigned to each Customer record.
Normally, you will want to accept this default.

If the payment is in another currency, you will have to
select a control account set with the matching currency,
or else set the field to be blank and then enter the GL
bank account and department below.

Acct/Dept If you leave the Account set field blank, you can
manually enter the G/L account and department to
which this payment will be applied in these fields. This
should be the G/L account for your bank.

If you have entered a value in the Account set field,
these fields will be filled in automatically, and will be
grayed out so that they cannot be edited. These fields
will display the G/L bank account and department
numbers as set up in the Control Account Set function.
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Field Description

Credit card /
Name on card

If you select a credit card payment method for this
customer and payment method, which you have
assigned to the customer in their customer file, Adagio
OrderEntry will automatically complete the credit card
information for you.

If this information is not in the customer file, you can
enter it manually.

Additionally, if you want to override the information in
the customer file, such as with a temporary credit card
number that they don’t normally use, you can enter it
here.

When you are finished entering the payment information, click OK and it will be
saved.
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Reporting
This chapter explains the impact that multicurrency databases have on Adagio
OrderEntry reports.

Common Currency Options

Choosing the Currency Data to Include
Several reports allow you to choose whether to print amounts in source or home
currency, or in both. For example, when you select Sales from the Reports |
Transactions menu, you are given the following currency options:

Reporting
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In the Amounts printed in currency section, you have these choices:

Field Description

Source Select this to have the report display source currency
amounts only. The report will not include any home
currency equivalent amounts if this option is selected.

Home Select this to have the report display home currency
equivalent amounts only. The report will not include
any source currency amounts if this option is selected.

Source + home NOTE: This option does not appear on all reports.

Choose this option if you want the report to include
your G/L transaction data in both the source and the
home currencies.

This option appears on the following reports:

• Print/Consolidate G/L Transactions;
• Summary Statistic;
• Tax Tracking.

Sorting Data by Currency
Some of the Transactions reports, such as the Sales and the Tax Tracking reports,
allow you to sort transactions by currency

Selecting Data by Currency
Edit functions that allow you to specify a currency, such as Miscellaneous charges,
also allow you to narrow that report’s criteria by currency. For example, if you want
to print all tax group data on file for a certain currency, you can select Tax groups
from the Reports | OrderEntry File Reports menu option, and then choose your
starting and ending Currency code in the report window.

Additional Reporting Features
• The Sales report allows you to print subtotals for each currency.
• In the Print Alternate Price Lists window, you must indicate one currency

that you wish to use for the report. This will print all of the alternate price list
items on file for that specific currency.

Reporting
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Appendix E
Adagio SalesAnalysis

Adagio SalesAnalysis is compatible with multicurrency databases. All information
pertinent to multicurrency transactions is retrieved and maintained.

The following fields will always be in home currency:

• Amount
• Base price
• Cost
• Margin
• Profit

The following fields will be in source currency for sales in foreign currencies and in
home currency for domestic sales:

• Discount %
• Source Amount
• Source Base Price
• Std, Unit $$ unit base price
• Unit Price

For multicurrency SalesAnalysis databases, these additional fields are accessible from
Crystal Reports for Adagio:

• Cost converted to source currency
• Date matching method
• Home currency code
• Source currency code
• # of decimals in source currency
• Rate
• Rate date
• Date matching
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• Rate type

This affects numerous reports and features in Adagio SalesAnalysis, as described in
the following sections.

Scanning / Retrieving Data
These functions will retrieve source amount, exchange rate, and other multicurrency
information.

Scanning / Retrieving Data
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Editing Sales Data
When you enter this function, the list of transactions displays all amounts in your
home currency, with the same number of decimal places you’ve set up for your home
currency.

When you drill down to a particular transaction, amounts are then displayed in
source currency instead.

Editing Sales Data
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The fields that display as source currency amounts are the Amount and Base price.

In addition to these source currency fields, you will see several additional fields::

Editing Sales Data
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The multicurrency fields are described below:

Field Description

Src. currency Displays the source currency for the transaction.

Rate type Displays the rate type (such as daily spot rate or monthly
average rate) that was used when entering the transaction.

If the Rate type requires an exact rate match -- that is, there
must be an exchange rate in your rate tables for the specific
transaction date -- but no exact match can be found,
SalesAnalysis will display a drop-down list with the exchange
rates on file so that you can select a rate.

Exch. rate Displays the exchange rate that was used to transfer the source
currency into home currency values. This rate is based on your
rate tables in Adagio MultiCurrency, by date of transaction.

Although this field cannot be modified directly, if you edit a
document’s date this field will change to reflect the
appropriate exchange rate for the revised date.

These fields cannot be edited for existing transactions. However, if you are adding
new data through the Edit function, the Src. Currency and Rate type fields are both
editable.

Editing Sales Data
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Item Inquiry
Both in the Item Inquiry list and when viewing an item, amounts are displayed in
your home currency, with the appropriate number of decimals you’ve set for your
home currency. No currency symbol is displayed.

Alternate Price Lists
In the Alt Prices Units tabs, you must select the currency code and price list for
alternate price lists. The alternate pricing information will then be displayed below as
before.

Item with Sales and Costs Inquiry
As with the standard Item Inquiry, described above, amounts in this function are
displayed in your home currency, without any currency symbol.

Alternate Price Lists
In both the Alt Prices/Costs and the Alt Prices Units tabs, you must select the
currency code and price list for alternate price lists. The alternate pricing information
will then be displayed below as before.

All prices, costs, and rounding amounts in the Alt Prices/Costs tab use the decimal
places specified in the alternate price list.

Sales History
This tab displays the sales amount and actual cost in the home currency.

Item Inquiry
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Reports

Standard Reports
Amounts on standard reports print only in your home currency, with home
currencies that are anywhere from 0-4 decimal places.

Statistics Reports
Amounts on statistics reports print only in your home currency, with home
currencies that are anywhere from 0-4 decimal places.

When using charts or graphs on your reports in Adagio
SalesAnalysis, all currencies will be limited to two decimal places,
due to a limitation in Crystal Reports.

Reports
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Online Inquiry
When creating or editing an inquiry template, you can place either home or source
amount fields on your inquiry.

The margin field will always be displayed with two decimals. All other amount fields
will be displayed in the home currency, with the number of decimals you have
selected for your home currency.

Online Inquiry
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Appendix F
Adagio Inventory

In conjunction with the Adagio MultiCurrency module, Adagio Inventory allows you
to work with multiple currencies through several special features, which are
discussed in the following chapters.

This manual covers multicurrency-specific functions. You may want to refer to the
Adagio Inventory manual for some basic information as needed.
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Multicurrency Overview
There are a few steps involved in using multicurrency data with Adagio Inventory,
from setting up your Inventory to work with multicurrency to processing
transactions.

The following topics explain the process briefly, and the chapters indicated will
provide complete information on each step.

Setting Up Your Inventory

Activating Multicurrency
The first step is to set up your currency codes and other multicurrency options in the
Adagio MultiCurrency module. Next, you need to turn on the multicurrency option
in your Company Profile in Adagio Inventory. This section explains the basics about
activating the multicurrency options.

Transaction Processing

Working with Transactions
When entering and editing receipts, there are some specific multicurrency fields of
which you should be aware.

Miscellaneous

Reporting
This section explains the impact that multicurrency data has on the standard reports
in Adagio Inventory.

Multicurrency Overview
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Activating Multicurrency
There are two basic steps in activating multicurrency for use in a particular Adagio
Inventory database:

1) Set up your currency information in the Adagio MultiCurrency module.

2) Turn the multicurrency option on in the Company Profile in Adagio Inventory
and set some defaults for multicurrency processing.

The following sections explain each of these steps.

Adagio MultiCurrency
Most of your multicurrency setup will be done in the Adagio MultiCurrency module,
which allows you to set up currency codes, rate types, and other data. See the
information earlier in this manual for complete details.

Editing the Company Profile

Activating Multicurrency
The Company Profile includes a multicurrency flag, which turns multicurrency on
for the database.

Activating Multicurrency
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To activate multicurrency:

1) Select Company Profile from the Edit menu, or click the Profile button on the
Toolbar. The Company Profile screen appears with the Company Data tab in
front.

2) Turn the Use multicurrency checkbox on if you want this data set to be able to
read in, post, and process data from multiple currencies. When you turn this
option on, certain fields and functions specific to multi-currency data sets will
become available to you.

Once you turn the multicurrency option on, you cannot turn it off
again. You may choose not to use the multicurrency functions in the
future, but you cannot simply turn it off at a future date.

3) This tab also specifies the Home currency, which is the default currency code
you’ve set up in Adagio Ledger.

4) In the Default Rate Type field, select your preferred default rate type for use in
Inventory. It should be the rate type you use most often. However, the default
rate type can be changed as needed when you are editing batches and so forth.

Rate types are set in the Adagio MultiCurrency module; for more information
rate types, you should refer to the Adagio MultiCurrency manual or help file.

5) Click OK to save the multicurrency settings in your Company Profile.

Activating Multicurrency
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GL Rounding Accounts
Multicurrency users will also want to indicate the account that any multicurrency
rounding errors will be written to.

This is done in the Integration tab of the Company Profile:

Complete the following field at the bottom of this tab:

Field Description

IC Rounding Enter the account and department you wish to use for
rounding errors that occur in your multicurrency
Inventory transactions.

Once you have set these options in your Company Profile, you are ready to begin
working with Adagio Inventory’s multicurrency functions.

Activating Multicurrency
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Setting up Report Printing
The Program Options function off the File menu includes some additional options
for multicurrency printing. Because some reports include both home and source
currency data, the reports tend to be wider. If you need to use some different settings
for your multicurrency printing needs, select File | Program Options. The following
window appears.

First, choose your Paper size. You can either choose to print multicurrency reports on
Legal paper, or on Letter paper on a printer that has been set up specfiically for such
purposes.

If you choose Legal, you can indicate whether Inventory should use your Default
printer or a Specific printer, and which Paper tray should be used in either case.

If you choose Letter on a dedicated scaled printer then you will simply need to
indicate the printer from the drop-down list that appears.

Activating Multicurrency
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Creating Alternate Price Lists
The alternate price list function may be especially useful to multicurrency users as it
allows you to quickly create a whole new set of alternate items for a specific
non-home currency using a specified exchange rate.

The process for creating alternate price lists with multicurrency Inventory data is
very similar to the standard procedure described in the Adagio Inventory manual.

However, when multicurrency data is present, you have a couple of extra options. To
view these options, select Create Alternate Price Lists from Price Lists | Alternate
Price Lists on the menu bar.

When you want to create a set of alternate items that should be used for non-home
currency customers, you must select a Currency code for those items, to indicate
which of the currencies these alternate items will be used for.

Once you have chosen all of your other selection criteria, you must then move to the
bottom of the window. In the section Create the selected fields using, click the
drop-down arrow on the first field and choose Exchange rate.

If you have not chosen a currency other than your home currency in the Currency
code field above, you will not be able to modify the Exchange rate field. If the
Exchange rate field is grayed out, please go back to the Currency code field and
ensure that you have selected an appropriate source currency.

When a source currency is properly selected and you have chosen to create the
alternate price list based on Exchange rate, another field will appear to the right,
which allows you to select the exchange rate you’d like to use. You can click the
Finder button to view a list of exchange rates on file (as entered in Adagio
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MultiCurrency), and choose from one of those rates. Or, you can manually type in
the desired exchange rate.

When you’re finished setting these fields, click Create. Adagio will create your
alternate price list items according to your criteria. Then, when you enter the
Alternate Price List Items function, you will see the new items listed along with their
currency.

Editing Tax Groups
Tax group set-up is also affected by multicurrency data.

When you have multiple currencies, you must assign a currency to each tax group
you create. Normally you would use home currency, but if you have vendors in
different countries and must remit taxes to jurisdictions in those countries, you may
need to set up tax groups accordingly.

A tax group is associated with every receipt, so there must be a tax group for every
currency code for which receipts will be created.

Adagio Inventory requires that you enter a jurisdiction for a tax
group.

Tax groups are set up in exactly the same way that the Adagio Inventory describes,
except that there is one additional field: Currency.

Simply indicate the currency that should be used for this tax group, making sure to
select an appropriate GL account for those taxes as well.

Activating Multicurrency
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Copying Tax Groups
Tax Groups can also be copied to help you speed up the tax group creation process. If
you want to copy an existing tax group and assign a new source currency to it,
simply select it in the Tax Groups window, then click Copy. You will be prompted
for a new tax group name.

Enter the new tax group name, and then you will be prompted for the source
currency that should be used for this new tax group.

Enter the desired source currency and click OK Your new Tax Group will be created
and you can modify it as needed.

Activating Multicurrency
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Working with Transactions
There is only one aspect of transaction processing that is affected when you are
working with a multicurrency data set: Receipt entry.

This chapter will explain the multicurrency options that impact this function.

Entering Receipts
Receipt entry is discussed fully in the Adagio Inventory manual, which can be
referred to for basic batch entry information. In this section, only those fields and
options that pertain to multicurrency will be explained.

Header Tab
When you are creating a new receipt, when you select a vendor in the first field of
the invoice window, some multicurrency information and options regarding that
vendor will appear:

On the left, the currency that is assigned to this vendor (according to their account
set) is listed, along with the rate type, such as “SP” for “spot rate” in this example.

Working with Transactions
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On the right, the Exchange rate field appears. This rate is taken from Adagio
Multicurrency’s exchange rate tables, and is chosen according to the rate type and the
date of the invoice you’re entering here.

If the rate type displayed to the left requires an exact match -- that is, there must be
an exchange rate in your rate tables for the specific transaction date -- but no exact
match can be found, you will be able to select a rate from the rates on file by clicking
on the Finder button.

You cannot change the currency on a receipt; vendor receipts will
always be entered in the currency that is used in the control account
set they’ve been assigned.

If you want a vendor to be invoiced in a different currency, you
must re-enter that vendor’s information and assign them to a home
or other source currency control account set.

Running Inquiries

Display Receipts
The currency data that was entered on the receipt (the vendor’s currency code and
the exchange rate used) will appear on the Display Receipt window.

Working with Transactions
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Reporting
This chapter explains the impact that multicurrency databases have on Adagio
Inventory reports.

Setting up Report Printing
The Program Options function off the File menu includes some additional options
for multicurrency printing. Because some reports include both home and source
currency data, the reports tend to be wider. If you need to use some different settings
for your multicurrency printing needs, select File | Program Options. The following
window appears.

First, choose your Paper size. You can either choose to print multicurrency reports on
Legal paper, or on Letter paper on a printer that has been set up specfiically for such
purposes.

If you choose Legal, you can indicate whether Inventory should use your Default
printer or a Specific printer, and which Paper tray should be used in either case.

If you choose Letter on a dedicated scaled printer then you will simply need to
indicate the printer from the drop-down list that appears.

Reporting
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Receipts Report
This report allows you to choose whether to print amounts in source or home
currency. When you print this report, you are given the following currency options:

In the Amounts printed in currency section, you have these choices:

Field Description

Source Select this to have the report display source currency
amounts only. The report will not include any home
currency equivalent amounts if this option is selected.

Home Select this to have the report display home currency
equivalent amounts only. The report will not include
any source currency amounts if this option is selected.

Reporting
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Transaction History Report
This report includes the option to print the amounts in home currency, or in both
home and source currency.

To include the source currency data for the receipts on this report, please turn on the
Print source currency amts checkbox.

Alternate Price Lists Report
This report requires you to specify a currency to use for your report. The report will
then print all alternate items for the chosen currency, according to your other
selected criteria as well.

Tax Tables and Tax Summary Reports
These reports will both will print currency information for each tax group on file.

Reporting
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Tax Tracking Report
This report asks you to select whether you want the tax data to be printed in the
source currency or the home currency.

Select Source to have all amounts printed in their source currencies; or select Home
to have all amounts printed in home currency, including source currencies which
have been converted to the home currency using the transaction’s exchange rate.

Reporting
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Print G/L Transactions
This report allows you to choose whether to print amounts in source or home
currency, or in both. You are given the following currency options:

In the Amounts printed in currency section, you have these choices:

Field Description

Source Select this to have the report display source currency
amounts only. The report will not include any home
currency equivalent amounts if this option is selected.

Home Select this to have the report display home currency
equivalent amounts only. The report will not include
any source currency amounts if this option is selected.

Source + home Choose this option if you want the report to include
your G/L transaction data in both the source and the
home currencies.

Reporting
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Appendix G
Adagio Invoices

In conjunction with the Adagio MultiCurrency module, Adagio Invoices allows you
to enter invoices in multiple currencies through a few special features, which are
discussed in the following chapters.

This appendix covers multicurrency-specific functions. You may want to refer to the
Adagio Invoices manual for some basic information as needed.
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Multicurrency Overview
There are a few steps involved in using multicurrency data with Adagio Invoices,
from setting up your Invoices to work with multicurrency to processing transactions.

The following topics explain the process briefly, and the sections indicated will
provide complete information on each step.

Setting Up Your Invoices

Activating Multicurrency
The first step is to set up your currency codes and other multicurrency options in the
Adagio MultiCurrency module. You will also need to ensure that your Adagio
Receivables data is 8.0 or higher and that you have turned the multicurrency flag on
in the Receivables Company Profile.

Next, you need to set up your tax tables. This section explains the basics about
activating the multicurrency options.

Invoices

Working with Transactions
Adagio Invoices uses exchange rates for non-home currency customers based on the
customer’s control account set, and allows you to choose alternate currencies for
applied payments.

Miscellaneous

Reporting
This section explains the impact that multicurrency data has on the standard reports
in Adagio Invoices.

Multicurrency Overview
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Activating MultiCurrency
There are two basic steps in activating multicurrency for use in a particular Adagio
Invoices database:

1) Ensure that you have Adagio MultiCurrency 8.0C or higher installed, and set up
your currency information in the Adagio MultiCurrency module.

2) Ensure that your Adagio Receivables data is 8.0A or higher and that you have
turned the multicurrency flag on in the Receivables Company Profile. (See your
Adagio Multicurrency manual for more information.)

3) Set up your tax tables for multicurrency processing.

The following sections explain each of these steps.

Adagio MultiCurrency
Most of your multicurrency setup will be done in the Adagio MultiCurrency module,
which allows you to set up currency codes, rate types, and other data.

Information on working with the MultiCurrency module can be found in the Adagio
MultiCurrency manual or help file.

Adagio Invoices will use the currency codes you’ve set up in your Receivables data
set. Currency code editing is documented in the Adagio Fundamentals manual or in
your Adagio Receivables or Adagio MultiCurrency help file.

Adagio Receivables
Ensure that your Adagio Receivables data is 8.0 or higher and that you have turned
the multicurrency flag on in the Receivables Company Profile. (See Appendix B for
more information.)

Additional Setup Options
Once you’ve turned the multicurrency flag on in Adagio Receivables, you may want
to create or update the data in your tax tables.

Editing Tax Groups
When you have multiple currencies, you must assign a currency to each tax group
you create. Normally you would use home currency, but if you have customers in
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different countries and must remit taxes to jurisdictions in those countries, you may
need to set up tax groups accordingly.

A tax group is associated with every invoice, so there must be a tax group for every
currency code for which invoices will be created.

Adagio Invoices requires that you enter a jurisdiction for a tax
group.

Tax groups are set up in exactly the same way that the Adagio Invoices manual
describes, except that there is one additional field: Currency.

Simply indicate the currency that should be used for this tax group, making sure to
select an appropriate GL account for those taxes as well.

Creating New Multicurrency Data
When you first turn on the multicurrency flag for Adagio Receivables, and then open
that data in Adagio Invoices, Adagio will create a new tax group using the Adagio
Receivables home currency code. It will be called tax group ‘1’ and titled ‘Default’.

Copying Tax Groups
Tax Groups can also be copied to help you speed up the tax group creation process. If
you want to copy an existing tax group and assign a new source currency to it,
simply select it in the Tax Groups window, then click Copy. You will be prompted
for a new tax group name.

Activating MultiCurrency
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Enter the new tax group name, and then you will be prompted for the source
currency that should be used for this new tax group.

Enter the desired source currency and click OK Your new Tax Group will be created
and you can modify it as needed.

Item Information
Adagio Invoices items do not require any additional setup for multicurrency
database.

However, it is important to note that all item costs that are displayed on-screen or in
reports anywhere in Adagio Invoices are in the home currency.

All item prices that appear on invoices and reports are in the customer’s currency.

You may wish to set up separate items for each currency so that the correct default
item price is used. Prices are not converted to other currencies automatically.

Activating MultiCurrency
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Working with Transactions
There are two primary aspect of transaction processing that are affected when you
are working with a multicurrency data set: how Adagio Invoices determines the
exchange rate for an invoice, and how applied payments are affected by
multicurrency processing.

This chapter will explain the multicurrency options that impact the invoice entry
function.

Exchange Rates on Invoices
Adagio Invoices gives you the opportunity to set the exchange rate for an invoice, in
the case of non-home currency customers.

Default Rate
By default, Adagio Invoices looks at the customer file, determines their control
account set, and then refers to the control account set for appropriate exchange rate
information for the default rate type and matching.

In Adagio Receivables, the control account set indicates the currency that should be
used, and it also indicates the rate type. Rate types enable Adagio to choose the
closest and most appropriate exchange rate for a transaction based on the exchange
rate data found in Adagio MultiCurrency.

When you create an invoice in Adagio Invoices, all of this information is compiled to
select the most appropriate exchange rate for this customer’s invoice, based on the
invoice date and the rate type. It then automatically takes the exchange rate from
Adagio MultiCurrency and applies it to the invoice.

Working with Transactions
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Changing the Rate
If you wish to change the default exchange rate that Adagio Invoices has entered for
an invoice, you can do so by going to the Totals tab for the invoice.

Simply go to the Rate field and use the Finder to select a rate type and rate from the
list that appears.

To view all rates for a certain rate type, click the + (plus) sign to the left of the rate
type code and then select a rate from the list that appears by double-clicking on it.

Working with Transactions
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Note that the currently selected rate is indicated by a small < sign to the right of the
rate.

Optional Amounts on Invoices
It is very important to note that all fields on invoices are in the customer’s currency
except the amount fields that appear on the Optional fields tab, and any item cost
information.

Those fields are stored in the Adagio Invoices database as home currency amounts.
The currency cannot be changed for these fields.

Applied Payments on Invoices
When you click the Payment tab on an Invoice for a customer whose currency does
not match the home currency, you will be given some exchange rate options.

By default, the payment currency and account set for the payment are the same as
for the customer.

The exchange rate displayed on the Payments tab comes from the invoice Totals
screen. The Discount shown here is also in the customer's currency.

Working with Transactions
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Changing the Payment Currency
If you wish, you may choose to change the currency of the payment: it does not have
to be the same as the customer. To change the currency, just go to the Currency field
and choose an alternate currency from the Finder.

When the payment currency is different than the customer’s currency, the equivalent
amount in the customer currency is also displayed. For example, here we have
entered a payment for a US dollar customer, but have changed the payment currency
to Canadian dollars. The USD Equivalent of $97.53 is displayed, along with the
exchange rate used to calculate it in the line above.

The payment currency and the Control Account set currency are required to be the
same.

If the payment currency selected does not match your company’s home currency or
the customer’s currency, note that the exchange rate field will also be come active.
You can edit this exchange rate to calculate the customer-currency equivalent. Just
use the Finder button to the right of the exchange rate displayed to select an alternate
rate.
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Adagio Invoices Page G-211



Payment
currency in
currency of
your choice

Discount
amount in
customer’s
currency

If you cannot edit the exchange rate, the customer’s currency
equivalent amount is for information purposes only.

If you are permitted to edit the exchange rate (that is, if the
payment occurs in a currency other than home or customer
currency), then this exchange rate is posted to Adagio Receivables
and Adagio Ledger along with the rest of the payment information.
It is then used to calculate the home equivalent amount of the
transaction.

The payment Discount will always be displayed in the customer currency, regardless
of the payment currency you set here.

Working with Transactions
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If you move over to the Totals tab for the invoice, you will note that the Less
payment amount displays the customer-equivalent amount paid on the Payments
tab, and the Less payment disc amount displays the customer-currency discount
amount.

Working with Transactions
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Reporting
This chapter explains the impact that multicurrency databases have on Adagio
Invoices reports.

Prices and Costs
All item costs that are displayed in Adagio Invoices reports are in the home
currency.

All item prices that appear on reports are in the customer’s currency.

Home Equivalent Amounts
The batch listings and posting journals display home equivalent amounts for
non-home currency customers.

Reporting
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Appendix H
Adagio BankRec

In conjunction with the Adagio MultiCurrency module, Adagio BankRec allows you
work with bank accounts that are not in your home currency, and to retrieve and
work with transactions in multiple currencies through a few special features, which
are discussed in the following sections.

This appendix covers BankRec's multicurrency-specific functions. You may want to
refer to the Adagio BankRec manual for some basic information as needed.
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Multicurrency Overview
There are a few steps involved in using multicurrency data with Adagio BankRec,
from setting up your BankRec to work with multicurrency to processing transactions.

The following topics explain the process briefly, and the chapters indicated will
provide complete information on each step.

Setting Up Your BankRec

Activating Multicurrency
The first step is to set up your currency codes and other multicurrency options in the
Adagio MultiCurrency module. You will also need to ensure that your Adagio
BankRec data is 8.0A or higher and that you have turned the multicurrency flag on in
the BankRec Company Profile.

Next, you need to set up your banks. This section explains the basics about
activating the multicurrency options.

Working with BankRec

Working with Batches
Adagio BankRec uses exchange rates for non-home currency customers and vendors
based on the their control account sets (set up in Adagio Receivables and Adagio
Payables), and allows you to choose alternate currencies for payments.

Inquiries
This section discusses the impact of multicurrency transactions on the Inquiry
functions.

Miscellaneous

Reporting
This section explains the impact that multicurrency data has on the standard reports
in Adagio BankRec.
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Activating MultiCurrency
There are two basic steps in activating multicurrency for use in a particular Adagio
BankRec database:

1) Ensure that you have Adagio MultiCurrency 8.0C or higher installed, and set up
your currency information in the Adagio MultiCurrency module.

2) Ensure that your Adagio BankRec data is 8.0A or higher and that you have
turned the multicurrency flag on in the BankRec Company Profile. (See your
Adagio Multicurrency manual for more information.)

The following sections explain each of these steps.

Adagio MultiCurrency
Most of your multicurrency setup will be done in the Adagio MultiCurrency module,
which allows you to set up currency codes, rate types, and other data. Information on
working with the MultiCurrency module can be found earlier in this manual.

Adagio BankRec will use the currency codes you’ve set up in your Adagio
MultiCurrency data set. Currency code editing is documented in the Adagio
Fundamentals manual or in the Adagio MultiCurrency help file.

Activating MultiCurrency
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BankRec Company Profile
Ensure that your Adagio BankRec data is 8.0A or higher and that you have turned
the multicurrency flag on in the BankRec Company Profile.

Activating MultiCurrency
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Here are your multicurrency options in this window:

Field Description

Use multicurrency Turn this checkbox on if you want this data set to be able to
read in, post, and process data from multiple currencies.
When you turn this option on, certain fields and functions
specific to multi-currency data sets will become available to
you.

NOTE: Once you turn the multicurrency option on, you cannot
turn it off again. You may choose not to use the multicurrency
functions in the future, but you cannot simply turn it off at a
future date.

NOTE: If you add BankRec to a MultiCurrency dataset, data
creation will have the 'Use multicurrency?' option turned on by
default.

Home currency If you add BankRec to an existing dataset, this field
defaults from the currency assigned to Adagio Ledger,
Adagio Payables, or Adagio Receivables data. If there is no
other data in the dataset, then the field displays the default
currency code you've set up in Adagio MultiCurrency.

Default rate type This field is available to users who've activated
multicurrency only.

Select your preferred default rate type for use in BankRec.
It should be the rate type you use most often. However, the
default rate type can be changed as needed when you are
editing batches and so forth.

Rate types are set in the Adagio MultiCurrency module; for
more information on rate types, you should refer to the
Adagio MultiCurrency manual or help file.

Number of
decimals

This field displays the number of decimals that are used for
the home currency you specify. It cannot be changed here;
it must be changed in Adagio MultiCurrency.

Activating MultiCurrency
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Additional Setup Options
Once you’ve turned the multicurrency flag on in Adagio BankRec, you must update
the data in your bank records.

Editing Banks
When you have multiple currencies, you must assign currency information to each
bank you use, to indicate the currency of that account.

To modify each bank, go to the Edit menu and select Banks. For each bank on file,
open it and begin by adding your currency information in the Bank tab.

Bank tab

Activating MultiCurrency
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At the bottom of this window you will see four currency fields:

Field Description

Check currency
code

Indicate the currency for this bank account, and therefore
the currency for checks and receipts.

Check rate type When you select a currency code other than your default
currency in the field above, you must indicate an exchange
rate type for checks drawn on this account. This rate type is
used in Adagio’s determination of the exchange rate that
should be used, such as a daily spot rate based on the date
of the transaction.

Rate types are set up in Adagio MultiCurrency. See the
Adagio MultiCurrency manual for more information on
how rate types work.

Reconciling
Currency

When checks are reconciled to your bank statement, the
statement may convert checks to your home currency, or it
may list the checks in the source currency.

In this field, indicate which currency is used for
reconciliation.

Reconciling rate
type

When you select a currency code other than your default
currency in the field above, you must indicate an exchange
rate type for your check reconciliation.

Rate types are set up in Adagio MultiCurrency. See the
Adagio MultiCurrency manual for more information on
how rate types work.
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Series tab
This tab also contains some multicurrency options:

On the bottom of this tab you will see some GL accounts that you must set for
clearing exchange rate differences and rounding:

Field Description

Clearing exch.
gain/loss

Set a GL account for exchange rate clearing gains and
losses to be written to. This is necessary, for example, in
cases where the source currency for the Bank and the
Customer match for a receipt, but the exchange rates do
not. In such a case, Adagio BankRec will calculate the
Exchange difference and post it to the Clearing Exchange
Gain/Loss account that was you set up here.

Currency rounding Enter a GL account for currency exchange rounding errors
here. Since exchange rates are often entered down to
several decimal places, rounding differences do occur.

Activating MultiCurrency
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Report Printer
You also need to set up your printer for multicurrency reports. Because of the added
data on multicurrency reports, there are special printing considerations.

To set up your printing options, go to File | Options. The following window
appears:

In the lower portion of this window, you'll see your MultiCurrency Report
Printer/Orientation Landscape options:

Field Description

Paper size Indicate whether you will be printing multicurency reports
on Legal paper, or on Letter on a dedicated scaled printer.
The multicurrency reports are designed to be printed on
legal paper; however, if you have a printer that can scale
legal-sized documents to letter-sized paper, you can select
that instead.
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Field Description

Legal Papersize
Printer/Bin

If you will be using your default Windows printer for
printing your Adagio BankRec multicurrency reports,
choose Default.

If you need to specify another printer that allows for
legal-sized paper or has the scaling feature mentioned
above, choose the Specific option instead, and then select
the desired printer from the drop-down field to the right.

Legal Paper tray Because many printers have multiple paper trays, you can
choose the tray that normally holds legal-sized paper for
your selected printer.

Click OK to save your report printer changes.
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Working with Batches
There are two primary aspect of batch processing that are affected when you are
working with a multicurrency data set: how Adagio BankRec determines the
exchange rate for a transaction, and how receipts and payments are affected by
multicurrency processing.

This chapter will explain the multicurrency options that impact the batch entry
function.

Retrieved Transactions
In the case of transactions that are retrieved into Adagio BankRec, from Payables and
Checks, the bank's currency is used, and the exchange rate for the bank's curency at
the time of the transaction is used.

Entered Transactions

Receipts
Adagio BankRec does not retrieve transactions from Adagio Receivables. Receipts
from customers should be entered into BankRec, and they will then be transferred to
Adagio Receivables.

When you enter a receipt from a customer during batch entry, the customer's
currency is used by default. This can be changed if needed, however.

Entering a Receipt
The following steps demonstrate how to enter a receipt from a non-home currency
customer. In this example, our home currency is USD, and our customer, Ables
Cables, uses the CAD Canadian currency.

1) Open the batch to which you wish to add the receipt, and click New to add a
new entry.
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First receipt line

Second receipt line

2) At the top of the window, select Receipts, and then enter the Customer code for
the non-home currency customer. Your screen will appear similar to this:

3) By default, the two receipt lines below the Check number field display first the
bank's currency, and then the customer's currency.

If you are receiving a payment in the bank's currency, enter that amount in the
first line (in our example, the USD Receipt field).

If you are receiving a payment in the customer's currency or another foreign
currency, click the Finder button to the right of the currency field on that first
receipt line and enter the appropriate currency there. Then, type in your receipt
amount.

4) If the currency of the payment does not match the customer's currency, the
second receipt line will display the equivalent amount of the receipt in the
customer's currency .

The equivalent amount in the customer's currency will be based on the exchange
rate field to the right. That rate is retrieved from Adagio MultiCurrency's rate
tables based on the rate type and the transaction date. If you want to accept this
rate, simply bypass the field. Or you can enter the exchange rate manually. If
you wish to view a list of exchange rates for the dates surrounding this
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transaction, click the Finder button beside the currency field and select an
exchange rate from the pop-up list that appears:

5) Once you've entered the receipt amounts, you'll see that the Unapplied field
shows the same amount as the customer's currency equivalent amount in the
second receipt line. That is the amount to be distributed.

6) From this point, you can distribute the receipt as usual. See your Adagio
BankRec manual for more information.

If the Source currency for the Bank and the customer match for a
receipt, but the exchange rates do not, Adagio BankRec will
calculate the Exchange difference and post it to the Clearing
Exchange Gain/Loss account that was set up in the Bank record.
The Exchange difference is shown on the Batch Listing and the Post
Journal reports.

Payments
The following steps demonstrate how to enter a payment to a non-home currency
vendor. In this example, our home currency is USD, and our vendor, Pacific Marine
Ocean Kayak, uses the CAD Canadian currency; thus, our invoices from them are in
Canadian dollars. We are entering the payment in a USD bank account, SIGNET.

1) Open the batch to which you wish to add the payment, and click New to add a
new entry.
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2) At the top of the window, select Payments, and then enter the Vendor code for
the non-home currency vendor. Your screen will appear similar to this:

Checks issued to vendors are in the bank's currency.

3) To add a payment:

• To apply a payment to a specific invoice, either highlight the invoice in the list
and hit the Spacebar; or double-click on that invoice in the list at the bottom of
the window and enter the amount you are paying in the Payment amount
field. This amount is in the vendor's currency.

If the check amount exceeds the amount on this invoice, enter the invoice
amount. You can apply the remainder of the check to other invoices or as a
prepayment.

• To enter a prepayment, click the New button on the lower right side of the
window. Select Prepayment at the top of the window and then enter the check
Amount. Again, this amount is in the vendor's currency.

4) When you return to the main entry window, you will see that Adagio BankRec
has entered the Check amount in the bank's currency.
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5) Adagio BankRec also displays the Total payable in the vendor's currency. This
amount is converted from the Check amount field by multiplying the Check
amount with the Vendor rate. That rate is retrieved from Adagio
MultiCurrency's rate tables based on the rate type and the transaction date. If
you want to accept this rate, simply bypass the field. Or you can enter the
exchange rate manually. If you wish to view a list of exchange rates for the dates
surrounding this transaction, click the Finder button beside the currency field
and select an exchange rate from the pop-up list that appears:

6)

Note that changing the exchange rate will not change the way the check is
applied to the transactions; it will only affect the Check amount itself.

7) When you're finished, click OK to save this transaction.

Payments that are entered in Adagio BankRec are automatically transferred to a
Manual Check Batch in Adagio Payables. They are assigned check numbers in
Adagio BankRec, so they will be non-printing checks.

Transfers
Bank transfers can be done from a bank account of one currency to a bank account of
another currency. To do this:

1) Open the batch to which you wish to add the transfer, and click New to add a
new entry. Ensure that the batch you open (or create) is for the bank you want to
transfer money to or from.
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2) At the top of the window, select Transfers.

Indicate whether the transfer is being made from this batch's bank, or to it; and
then enter the bank code for the bank the money is being transferred from/to in
the To bank / From bank field. Your window will appear similar to this:

3) You have two options:

• Enter the amount in this batch's bank currency field -- in our example, the
USD Transfer field. If you're transferring money from this account, that will
be the amount that is removed from this account. It will then be converted to
the receiving bank's currency. If you're transferring money to this account, that
will be the amount that this account receives, in the same currency this bank
uses. Or,

• Enter the amount in the other bank's currency -- in our example, the CAD
Transfer field. In this case, the actual amount that is transferred from or to the
account will be displayed in the USD Transfer field instead, after being
converted by the value displayed in the Transfer rate field. However:

• Note that if the first transfer field does not have an amount of 0.00, then
when you enter a value in the second transfer field, Adagio BankRec will
recalculate the exchange rate, rather than replace the amount in the first
transfer field with the amount of the second transfer field multiplied by
the previous exchange rate.
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• To avoid errors, you will usually want to ensure that the amount in the
first transfer field is 0.00 when you enter an amount in the second transfer
field.

4) Adagio BankRec will automatically calculate the equivalent amount of the
transfer in the other bank's currency. This amount is based on the Transfer rate,
which is retrieved from Adagio MultiCurrency's rate tables based on the rate
type and the transaction date. If you want to accept this rate, simply bypass the
field. Or you can enter the exchange rate manually. If you wish to view a list of
exchange rates for the dates surrounding this transaction, click the Finder button
beside the currency field and select an exchange rate from the pop-up list that
appears:

5) Click OK to save this batch entry.
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Inquiries
This chapter discusses the impact of multicurrency transactions on the Inquiry
functions.

Batch Status Inquiries
All amounts displayed in the Batch Inquiry function are the sum of the Checks
amounts listed in the Payment/Receipt currency.

Receipt History Inquiries
The Receipt tab of the Receipt History function includes two fields with
multicurrency information for historical receipts:

Field Description

[CUR] Bank Rate Displays the exchange rate that was used for the receipt.

[CUR] Receipt /
[CUR] Cust Receipt

The two receipt lines below the Receipt number field
display first the bank's currency, and then the customer's
currency. The payment amount in the bank's currency
appears in the first line, and the payment amount in the
customer's (or other foreign) currency appears in the
second line.

Inquiries
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Bank Inquiries

Amounts
1) The Bank Inquiry function (available by selecting Balances from the Inquiries

menu) displays the balances for each bank in its own currency in the As Of
Balance column. However, it also displays the home equivalent balance amount
of all banks, in the lower right corner of the window.

If you View a bank by selecting it in the list above and clicking View, the
Transaction info window will display full currency information for each transaction
as well.

• For receipt and deposits, the Total Receipt field displays the bank equivalent
amount of the check/cash received.

• For payments, the Total Payment field displays the currency that the payment
was issued in.

• The Home equivalent field displays the home currency equivalent amount,
based on the Bank rate that was used to process the transaction.

• The Cleared amount field displays the currency that was used when the
amount was reconciled. This is almost always the same as the currency that
the payment was issued in.

Inquiries
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Reconciliation

Check Reconciliation
When you're in the Bank Inquiry List (available by choosing Balances from the
Inquiries menu), you can click the Reconcile button to reconcile that bank's
transactions.

In the main reconciliation window, there is currency information in the upper left
corner of the window. The currency code displayed here indicates the currency of the
bank you're working with.
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Additionally, when you open a specific transaction for reconciling, by
double-clicking on it, you will see the currency of the transaction displayed next to
the Issued amount field.

If you need to edit the Cleared amount, you must specify the cleared amount in the
reconciling currency .

If the bank is set up with the same currency for both the Check currency code and the
Reconciling Currency, then you will be able to alter the cleared amount by selected
the Cleared with error radio button.

If the bank’s reconciling currency does NOT match the Check currency, then you will
instead need to select the Cleared with difference option.

The Ledger account that is debited or credited with any difference between the
written check and the cleared amount is set in the Edit Banks function.

Electronic Reconciliation
When you are using BankRec's electronic reconciliation feature, Adagio assumes that
your transactions are all in the bank's currency. If this is not the case, the electronic
reconciliation feature will not work for you.
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NSF Checks
When you are viewing a Customer receipt from the Bank Inquiry function, you can
indicate that a check was returned NSF. Some currency information will be included
on the NSF check window.

1) To mark a check NSF, select Balances from the Inquiries menu, then open the
bank that returned the check NSF, and find the transaction in the list. Click
View.

2) Select the transaction that has been returned and click the NSF Check button.
The following window appears:

3) The top portion of this window, NSF Check, indicates the document number
and the NSF Process on date field, where you can set the date that the bank
declined the check.

Next you'll see the Receipt amount, which displays the amount of the check
along with the currency for the check.

In cases where the customer didn’t pay in their usual currency, you will also see
another field for the Customer receipt amount, which indicates the amount of

the receipt in the customer’s currency.

4) The Customer Charges section includes the Customer fee field, which
automatically inserts your default NSF charge, as indicated on the Options tab of
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the Company Profile. However, you can change this amount if needed. This
amount will always be in the customer's currency.

5) Finally, the Bank Charges section includes a Bank fee field, where you can enter
the bank's NSF check fee. This will always be in the bank's currency.
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Reporting
This chapter explains the impact that multicurrency databases have on Adagio
BankRec reports.

Amounts
All amounts for vendor or customer transactions in Adagio BankRec are in the
vendor's or customer's curency.

Home Equivalent Amounts
The following reports include an option to Show home equiv. balance on the report.
This option is useful for foreign currency bank accounts, where you'd like to see the
bank's actual balance and also the home equivalent balance.

• Batch Listing
• Batch Posting Journal
• Bank Transactions
• Bank Reconciliation
• Reconciliation Worksheet

Bank Equivalent Amounts
The Batch Listing report will print the Bank Equivalent amount for transactions in
cases where the source currency of the receipt is not the same as the bank's currency.

Home and Source Currencies
Two reports, Print/Consolidate G/L Transactions and Tax Tracking, include an
option to print amounts in either:

• Source currency,
• Home currency, or
• both Source + home currency.

If you choose only Source or Home, the report will simply have totals in the chosen
currency in a column on the right side of the report.

If you choose Source + home, two columns of totals will appear on the right side of
the report.

Reporting
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